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Copyright and Disclaimer

 

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc. The 
software described in this document is furnished under a license agreement. The software may not be reverse assembled and may be 
used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any medium 
except as specifically allowed in the license agreement. Avid products or portions thereof may be protected by one or more of the fol-
lowing patents: 4,746,994; 4,970,663; 5,045,940; 5,077,604; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 
5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,583,496; 5,584,006; 5,627,765; 5,634,020; 5,640,601; 
5,644,364; 5,654,737; D352,278; D372,478; D373,778. No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of 
Avid Technology, Inc.

 

© Copyright Avid Technology, Inc. 2/98. All rights reserved. Printed in USA.

The following disclaimer is required by Apple Computer, Inc.

 

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PROD-
UCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PUR-
POSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT 
APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU 
MAY HAVE WHICH VARY FROM STATE TO STATE.

 

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library

 

Copyright © 1988-1997 Sam Leffler 
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and 
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating 
to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CON-
SEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROF-
ITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF 
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

 

The following disclaimer is required by the Independent JPEG Group

 

This software [i.e., the JPEG modules] is based in part on the work of the Independent JPEG Group.

 

The following disclaimer is required by Ray Sauers Associates, Inc.

 

“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equiva-
lent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any 
damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s 
products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Dam-
ages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason 
including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known 
of the possibility of such damages.

 

The following disclaimer is required by Videomedia, Inc.

 

“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect 
to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videome-
dia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software 
will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

 

Attn. Government User(s). Restricted Rights Legend
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U.S. GOVERNMENT RESTRICTED RIGHTS. Use, duplication or disclosure by the government of the software, documentation and 
other technical data is subject to restrictions as set forth in subparagraph (c) of FAR clause 52.227-19, COMMERCIAL COMPUTER 
SOFTWARE-RESTRICTED RIGHTS or, in the case of the Department of Defense or its contractor, is subject to DFARS 227.7202-3, 
Rights in Commercial Computer Software or Commercial Computer Software Documentation.

 

Electromagnetic Compatibility

FCC Notice

 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired oper-
ation.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commer-
cial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will be required to correct the interference at his own expense. Ref: C97029a

 

Canadian ICES-003 

 

This Class A digital apparatus meets all requirements of the Canadian Interference Causing Equipment Regulations.

Cet appareil numérique de class A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

 

Declaration of Conformity (according to ISO/IEC Guide 22 and EN 45014)

 

Application of Council Directives: 73/23/EEC, 89/336/EEC. Standards to which Conformity is Declared: EN 60950: 1992 + A1, A2: 
1993, IEC950: 1992 + A1, A2: 1993 Mod., CISPR 22:1985 / EN 55022:1988 Class A (1), EN 50082-1, IEC801 -2, -3, -4. Manufacturer’s 
Name: Avid Technology Inc., 1925 Andover Street, Tewksbury, MA 01876, USA. European Contact: Nearest Avid Sales and Service 
Office or Avid Technology Int’l B.V., Sandyford Business Center, Unit 3, Dublin 18, Ireland. Type of Equipment: Information Technology 
Equipment. Product Name: Avid Editing System, PCI Media Composer, MCXpress for Macintosh, Film Composer. Base Model Num-
bers: 400S, 800, 900, 1000, 4000, 8000, MC Offline, Media Station. Product Options: All. Year of Manufacture:1997. (1) The product 
was tested in a typical Avid Media Composer configuration.

I the undersigned, hereby declare that the equipment specified above conforms to the above Directives and Standards.

George R. Smith, Quality Manager      Ref: C97029a, C97030a
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Trademarks

 

AirPlay, AudioVision, Avid, FieldPak, Film Composer, HIIP, Image Independence, Media Composer, MediaMatch, Media Recorder, 
Media Suite, NewsCutter, OMF, OMF Interchange, Open Media Framework, and the Avid logo, are registered trademarks and 
Advance, AniMatte, AudioStation, AutoSequence, AutoSync, AVIDdrive, AVIDdrive Towers, AvidDroid, AvidNet, AVIDstripe, Avid 
Xpress, Film Cutter, Krypton, MCXpress, Media Fusion, Media Illusion, MediaLog, Media Reader, MediaServer, and MediaShare, and 
Tools for Storytellers are trademarks of Avid Technology, Inc. Digidesign is a registered trademark and Audiomedia II, Audiomedia III, 
Pro Tools, Sound Accelerator II, Sound Designer II, Sound Tools II, and Video Slave Driver are trademarks of Digidesign, a division of 
Avid Technology, Inc. Elastic Reality and TransJammer are registered trademarks and the Elastic Reality logo is a trademark of Elastic 
Reality, Inc., a division of Avid Technology, Inc. Matador is a registered trademark of Avid Technology, Inc. in the United Kingdom.

3D Studio and Animator Pro are registered trademarks and FLIC is a trademark of Autodesk, Inc. in the USA and/or other countries. 
Abekas is a registered trademark of Scitex Digital Video, Inc.; Adobe After Effects, Adobe Illustrator, Adobe Photoshop, Adobe Pre-
miere, Adobe Type Manager, and PostScript are trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered 
in certain jurisdictions. Alias and Alias/Wavefront are registered trademarks and Alias Animator and Alias PowerAnimator are trade-
marks of Alias/ Wavefront; America Online is a registered trademark of America Online, Inc.; AmiLink CIP and AmiLink POST! are 
trademarks of RGB Computer and Video, Inc.; Ampex is a registered trademark of Ampex Corporation. Apple, AppleShare, AppleTalk, 
LaserWriter, Mac, Macintosh, Macintosh Quadra, QuickDraw, QuickTime, PowerBook, Power Macintosh, and TrueType are trademarks 
of Apple Computer, Inc., registered in the United States and other countries. Balloon Help and Finder are trademarks of Apple Com-
puter, Inc. AudioFile is trademarked in the United Kingdom by AMS Neve PLC; Boris FX is a trademark of Artel Software, Inc.; Cineon 
is a trademark of Eastman Kodak Company; CLARiiON is a registered trademark of Data General Corporation; Claris and FileMaker 
are registered trademarks of Claris Corporation; CMX is a trademark of CMX Company; Compaq is a registered trademark of Compaq 
Computer Corporation; CompuServe is a registered trademark and GIF is a service mark property of CompuServe, Inc.; DOS Mounter 
is a trademark of Dayna Corporation; Dyaxis II is a trademark of Studer Editech Corp.; FirstClass is a trademark of SoftArc, Inc.; Flame 
and Flint are trademarks of Discreet Logic, Inc.; FLEx is a trademark of Pioneer-Standard Electronics, Inc.; FLEXlm is a registered 
trademark of Globetrotter Software, Inc.; Hitachi is a registered trademark of Hitachi, Ltd.; IBM and OS/2 are registered trademarks of 
International Business Machines Corporation; iNFiNiT! is a trademark of Chyron Corporation; Inscriber is a registered trademark of 
Image North Technologies; Intel and Pentium are registered trademarks of Intel Corporation; Key-Log is a trademark of Evertz Micro-
systems, Ltd.; Mackie Mixer is a trademark of Mackie Designs, Inc.; Match-Maker is a trademark of Audio Technologies Inc.; Media-
sound is a trademark of TimeLine Vista, Inc.; Micropolis is a registered trademark of Micropolis (S) PTE Ltd.; Microsoft, MS-DOS, and 
Windows are registered trademarks and Excel is a trademark of Microsoft Corporation; Motorola is a registered trademark of Motorola 
Corporation; Mylar is a trademark of E.I. duPont de Nemours & Co., Inc.; NuBus is a registered trademark of Texas Instruments, Inc.; 
NuVista+ is a registered trademark of Truevision, Inc.; Panasonic is a registered trademark of Matsushita Electric Industrial Company, 
Limited; PC Paintbrush is a trademark of Zsoft Corporation; Practical Modem is a trademark of Practical Peripherals, Inc.; PyraMix is a 
trademark of Merging Technologies; RCA is a registered trademark of General Electric Company; Seagate is a registered trademark of 
Seagate Technology; Silicon Graphics is a registered trademark of Silicon Graphics, Inc.; Speed of Sound Library is a trademark of 
Aware, Inc.; Softimage is a registered trademark of Softimage, Inc., a wholly owned subsidiary of Microsoft Corporation, in the United 
States and/or other countries; Sony is a registered trademark of Sony Corporation; S/Link is a trademark of The Synclavier Company; 
Still File Storage is a trademark of Leitch Video; Sun is a trademark or registered trademark of Sun Microsystems, Inc. in the United 
States and other countries; TARGA, TARGA 2000, and Truevision are registered trademarks of Truevision, Inc.; Trans/Port is a trade-
mark of OSC S.A.; Ultimatte is a trademark of Ultimatte Corporation; Vantage is a trademark of Baseline Software, Inc.; Video Explorer 
is a trademark of Intelligent Resources Integrated Systems; Video Toaster is a trademark of NewTek Inc.; V-LAN and VLXi are regis-
tered trademarks of Videomedia, Inc.; WordPerfect is a registered trademark of WordPerfect Corporation; X Window System is a trade-
mark of X Consortium, Inc. All other trademarks and registered trademarks used herein are the property of their respective owners.

 

Footage

 

Bullfrog, Duckhead, and Rain Forest footage was provided courtesy of Fireside Films, Atlanta, GA; Canyonlands and Flowers footage 
was provided courtesy of the National Park Service, Harpers Ferry, VA; Softrock (Fields of Gold) footage was provided courtesy of 
SouthPaw Productions Chicago, IL. Peter Hawley-Director, Jim Fiester-Director/Editor. 
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Preface

This guide provides information about how to get started using your 
Avid¨ Media Composer¨ system.

Who Should Use This Manual

This guide is written for video and Þlm editors who are learning to use 
an Avid Composer system.

About This Manual

The Table of Contents that precedes this preface lists all topics 
included in the book. They are presented with the following overall 
structure:

¥ Chapter 1 explains how to turn on your system, install the tutorial 
media, and use the online help and online documentation.

¥ Chapter 2 presents basic editing concepts and walks you through 
a typical workßow scenario.

¥ The main body of the guide presents introductory material on var-
ious aspects of your work, followed in most chapters by a tutorial 
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section. Step through the tutorial for guided hands-on experience 
with your Media Composer system.

¥ A detailed Index helps you quickly locate speciÞc topics. 

This guide should get you started. For more information, see the 
online help and the Avid Media Composer UserÕs Guide.

Symbols and Conventions

The Media Composer documentation uses the following special sym-
bols and conventions:

1. Numbered lists, when order is important.

a. Alphabetical lists, when the order of secondary items is 
important.

¥ Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of subtopics is unim-
portant.

k This symbol refers to the Apple or Command key. Hold down the 
Command key and another key to perform the desired keyboard 
equivalent.

Look here in the margin 
for tips.

In the margin you will Þnd tips that help you perform tasks more eas-
ily and efÞciently.

n A note provides important related information, reminders, recommendations, 
and strong suggestions.

c A caution means that a speciÞc action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in the manual or on the unit itself when han-
dling electrical equipment.
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If You Need Help

If youÕre having trouble using Media Composer, you should:

1. Retry the action, carefully following the instructions given for that 
task in this guide.

2. Check the documentation that came with your hardware for main-
tenance or hardware-related issues.

3. Check the Services & Support section of the Avid web site at 
http://www.avid.com for the latest FAQs, Tips & Techniques, 
Avid Answers, and other Avid online offerings.

4. Check the Avid Bulletin Board, ÒAvid Online,Ó for information on 
product and user conferences. If you do not Þnd the solution to 
your problem, you can exchange information with other Avid cus-
tomers and Customer Support representatives.

5. Contact Avid Customer Support at 800-800-AVID (2843).

Related Information

The following documents provide more information about Media 
Composer:

¥ Avid Media Composer UserÕs Guide

¥ Avid Media Composer Products Reference

¥ Avid Media Composer and Film Composer Effects Guide

¥ Avid Media Composer Products Site Preparation

¥ Avid Media Composer Products WhatÕs New for Release 7.0

¥ Avid Media Composer Products Quick Reference

¥ Avid Media Composer Products Online Documentation

You can get help while you use your Composer system from the online 
help.
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If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. 
We value your comments about this manual or other Avid-supplied 
documentation.

E-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, revision, and 
the speciÞc section youÕre commenting on in all correspondence. 
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CHAPTER 1

Introduction

This chapter sets you up to use this guide and work through the tuto-
rial sections that teach you the basics of your Avid Composer system. 
This chapter contains the following sections:

¥ Using this Guide

¥ Using the Tutorial

¥ What You Need

¥ Turning on Your Equipment

¥ Installing the Media Composer Tutorial Files

¥ Launching the Media Composer Application

¥ How to Proceed

¥ Using Online Help

¥ Using Online Documentation

Using this Guide

This guide introduces you to Media Composer. It presents the essen-
tial features of the system; most chapters also contain hands-on tuto-
rial sections so you can practice what you learn.
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Using the Tutorial

The self-paced tutorial sections included in this guide are designed as 
guided Avid edit sessions using the basic features of the Media Com-
poser system. In the tutorial sections, youÕre going to edit a one-
minute sequence about a company in Amesbury, Massachusetts that 
makes small Þshing boats called dories.

The footage for the sequence is on the Media Composer Tutorial CD-
ROMs that came with your system. They contain digitized media that 
is ready for you to use.

The instructions in this tutorial take you through each step of the edit 
process:

¥ Starting a project (in Chapter 3)

¥ Getting ready to edit (in Chapter 5)

¥ Editing a rough draft (in Chapter 6)

¥ ReÞning the edit (in Chapter 7)

¥ Adding effects, titles, and other Þnishing touches to the sequence 
(in Chapter 8 and Chapter 9)

¥ Preparing output (in Chapter 10)

¥ Backing up (in Chapter 11)

This tutorial assumes a basic familiarity with the Macintosh¨ com-
puter. If you have never used a Macintosh system, please refer to the 
Macintosh Getting Started tutorial.

You donÕt need any previous experience with the Avid Composer sys-
tem. The terms and techniques needed for each tutorial section are in 
each chapter. However, it will help to read Chapter 2 of this manual 
before starting any of the tutorial sections. You can also use the Avid 
Composer Help (see ÒUsing Online HelpÓ on page 31) and online 
books (see ÒUsing Online DocumentationÓ on page 33) for more 
information. 
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This tutorial takes approximately four hours. Before you begin, you 
need:

¥ An installed Avid Media Composer system

See the Avid Media Composer Products Setup Guide if you have not 
yet set up your Media Composer  system. See the Avid Media 
Composer and Film Composer Release 7.0 Release Notes if you need to 
install the Media Composer software.

¥ The Boat Shop media and project Þles on the Media Composer 
CD-ROMs

Depending on your level of expertise in editing on Avid systems, you 
may choose to go through the tutorial in either of two ways.

¥ If you have no experience with Media Composer or other Avid 
systems, you should go through the entire tutorial. 

¥ If you have used other Avid systems, you may want to read cer-
tain lessons to understand the speciÞc features of
Media Composer, and complete the tutorials for other lessons.

You can do this tutorial in one or several sessions. Each section is self-
contained.



22

What You Need

The CD-ROMs packaged with your Media Composer system include 
all Þles necessary to do this tutorial:

¥ Read Me First Þle Ñ contains the installation instructions for each 
of the Þles on the CD-ROMs. These instructions also appear in 
ÒInstalling the Media Composer Tutorial FilesÓ on page 25.

¥ MediaFiles folder Ñ contains the digitized Þles you need for the 
tutorial. You need to copy these Þles onto your external media 
drive.

¥ Composer Projects folder Ñ contains the project and bins you 
need for the tutorial. You need to copy these Þles onto your Avid 
drive.

Turning on Your Equipment

Begin your edit session by turning on the components of your Media 
Composer system. If any part of your system fails to turn on, make 
sure its electrical cord is plugged snugly into an appropriate electrical 
outlet or power strip. See the Avid Media Composer Products Setup Guide 
for information on setting up your system.

c If you fail to follow the proper sequence for starting up your system, 
you could damage your Macintosh computer and/or storage drives.

Always turn on the devices as follows:

1. Fixed-storage drives: Turn on Þxed-storage drives before starting 
the computer. Allow 10 to 15 seconds for the drives to spin up to 
speed before starting the Macintosh.

2. Other peripheral hardware: Turn on all other peripheral units 
except the Macintosh. This includes:

¥ Monitors and speakers.



23

¥ Tape decks and/or additional autoassembly conÞgurations 
(switcher, time-base corrector, and so on) if you plan to digi-
tize or conduct an autoassembly.

¥ Digidesign¨ audio interface hardware, if your system 
includes these. Turn on the Digidesign hardware and black 
burst generator in order to maintain proper sync between 
audio and video while digitizing and editing.

n The black burst generator that accompanies the Digidesign hardware should 
already be turned on if it is connected to an active power strip.

3. The Macintosh: Press the Power On key located at the upper right 
corner of the keyboard.

When you start the Macintosh:

¥ You hear a tone that means the hardware is operational.

¥ The computer goes through a self-check routine. If the
Macintosh passes all of its internal logic tests, the smiling
Macintosh icon appears.

For information on 
Macintosh features, 
such as the desktop and 
icons, see your Macin-
tosh documentation.

¥ The Avid startup screen appears and the initialization process 
begins.



24

¥ The Macintosh desktop appears.

c To avoid damage, do not disconnect or turn off hard disks or indi-
vidual disk drives while the Macintosh is on.

Avid drive

Media

(external)

(internal)

drives
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Installing the Media Composer Tutorial Files

The Media Composer Tutorial CD-ROMs contain all of the Þles you 
need for the tutorial sections of this guide. It takes about 30 minutes to 
copy the media Þles from the CD-ROM to the external hard drive.

The CD-ROMs contain several versions of the tutorial media Þles digi-
tized at different Avid Video Resolutions (AVRs). You must select the 
appropriate AVR for your Media Composer product model. Table 1-1 
shows the correct tutorial media for your product. You also need to 
have enough free space on your external hard drive to accommodate 
the media sizes listed in the table.

Table 1-1 Choosing Media

If you have: Use: On the CD-ROM named: Media Size

Media Composer Ofßine AVR 3s Avid Media Composer Products
Ofßine Tutorial (PAL and NTSC)

260 MB

Media Composer online
models with striped drives

AVR 70 Avid Media Composer Products
Online Tutorial (PAL) Disks 1 and 2 

Avid Media Composer Products
Online Tutorial (NTSC) Disks 1 and 2 

1100 MB

970 MB

Media Composer online
models without striped drives

AVR 3s Avid Media Composer Products
Ofßine Tutorial (PAL and NTSC)

260 MB
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Installing AVR 3s Tutorial Files

To install the tutorial Þles for AVR 3s:

1. Insert the Avid Media Composer Products Ofßine Tutorial (PAL 
and NTSC) and double-click its icon.

2. Double-click the folder at the top level of the CD-ROM. 

3. The AVR 3s CD-ROM has two top-level folders. Choose NTSC or 
PAL.

You should see two folders labeled Composer Projects and 
OMFI MediaFiles.

4. Do one of the following:

¥ If there is an existing OMFI MediaFiles folder on the external 
media drive, open the OMFI MediaFiles folder on the CD-
ROM, choose Select All from the Edit menu, and drag the con-
tents to the OMFI MediaFiles folder on the external media 
drive.

¥ If there is no OMFI MediaFiles folder on the external media 
drive, drag the OMFI MediaFiles folder from the CD-ROM to 
the external media drive.

The Þles are loaded on the drive.

5. Do one of the following:

¥ If there is a Composer Projects folder on the Avid drive, open 
the Composer Projects folder on the CD-ROM and drag the 
Boat Shop folder to the Composer Projects folder on the Avid 
drive.
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¥ If there is no existing Composer Projects folder on the drive, 
drag the Composer Projects folder on the CD-ROM to the
Avid drive.

Installing AVR 70 Tutorial Files

The tutorial Þles for AVR 70 require two CD-ROMs for NTSC and two 
for PAL. The procedure is the same for installing either type.

To install the tutorial Þles for AVR 70:

1. Insert the CD-ROM labeled Avid Media Composer Products 
Online Tutorial (PAL) Disk 1 or Avid Media Composer Products 
Online Tutorial (NTSC) Disk 1 and double-click its icon.

2. Double-click the folder at the top level.

You should see two folders labeled Composer Projects and
 OMFI MediaFiles.

3. Do one of the following:

¥ If there is an existing OMFI MediaFiles folder on the external 
media drive, open the OMFI MediaFiles folder on the CD-
ROM, choose Select All from the Edit menu, and drag the con-
tents to the OMFI MediaFiles folder on the external media 
drive.

¥ If there is no existing OMFI MediaFiles folder on the external 
media drive, drag the OMFI MediaFiles folder from the CD-
ROM to the external media drive.
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The Þles are loaded on the drive.

4. Do one of the following:

¥ If there is an existing Composer Projects folder on the Avid 
drive, open the Composer Projects folder on the CD-ROM and 
drag the Boat Shop folder to the Composer Projects folder on 
the Avid drive.

¥ If there is no existing Composer Projects folder on the Avid 
drive, copy the Composer Projects folder on the CD-ROM to 
the Avid drive.

5. Eject the CD-ROM in the drive.

6. Insert the CD-ROM labeled Avid Media Composer Products 
Online Tutorial Disk 2 and double-click its icon.

7. Double-click the top folder.

You should see a folder labeled OMFI MediaFiles-2.

8. Choose Select All from the Edit menu, and drag the contents to the 
OMFI MediaFiles folder on the external media drive.
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Launching the Media Composer Application

The Media Composer application icon is located in the Media Com-
poser folder on the Avid drive. For most users, the desktop or the 
Apple menu is a more convenient location for launching the applica-
tion. 

n The application will not launch properly if the icon is moved out of the Media 
Composer folder. To launch the application from a convenient location, Avid 
recommends that you create an alias and place it in a convenient location.

For more information 
on making an alias and 
using the Apple menu, 
see your Macintosh 
documentation.

To launch the application, double-click the application icon or alias, or 
choose it from the Apple menu. The Avid splash screen appears.

Specifying Audio Hardware

The Þrst time you launch the application, a dialog box appears.

Check your audio hardware conÞguration, then do one of the follow-
ing:

¥ If your audio hardware is labeled Audio Interface, click Digide-
sign 442 in the dialog box.

¥ If your audio hardware is labeled 8 Channel Audio Converter, 
click Digidesign 888.
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The Avid splash screen returns, then the License Agreement dialog 
box appears.

Electronic Licensing

To accept your Avid Composer product license electronically:

1. Read the License Agreement, then click the Accept button or the 
Decline button at the bottom of the screen.

The agreement appears the Þrst several times you launch the 
application. After several launches, a new button appears at the 
bottom of the screen.

2. If you do not want to see the license agreement again, click the 
Accept and DonÕt Show Again button.

A dialog box appears.

3. Enter the name of your organization in the dialog box, and click 
OK.

After the application starts, the Project Selection dialog box 
appears, as described in ÒOpening a ProjectÓ on page 51.

How to Proceed

The following are a few tips for taking full advantage of 
Media Composer documentation and other resources:

¥ Complete the tutorial sections in this book before starting a 
project.

¥ Begin learning about basic procedures by using the default set-
tings. As your conÞdence builds, begin to explore additional pro-
cedures and settings.
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¥ Keep the Avid Media Composer and Film Composer Quick Reference on 
hand during sessions to speed the use of functions, shortcuts, key-
board commands, menus, and icons. 

¥ Make a habit of reading AvidÕs newsletters, mailings, and other 
trade publications.

¥ Make use of additional training resources provided by Avid when-
ever possible, such as classes and instructional videotapes. For 
more information, contact Avid at 800-867-2843.

¥ Check the Avid web site at www.avid.com/services/training/
training.html for listings of courses, schedules, and locations.

Using Online Help

This release supports online help for your Avid Composer system. The 
online help is automatically installed with the application.

You can access online help in two ways:

¥ From the question mark menu in the upper right corner of your 
screen, choose Composer Help.

¥ As context-sensitive help:

a. Position the cursor on the window for which you want help.

b. Make sure your Avid Composer system is active.

c. Press the Help key on the keyboard.

A window appears representing the tool or feature for which 
you want help.

d. Click on different aspects of the tool or feature to see pop-up 
help.

n If no speciÞc help for the window exists, the Topics window appears.
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Procedures are displayed in yellow How To windows; background 
information and illustrations are displayed in white Reference 
windows.

The following sections explain how to use the help system. For more 
information, see ÒOnline Help:overviewÓ in the online help index.

Three Ways of Finding Topics in Help

To Þnd a topic in Help:

1. Open the Topics window.

2. Do one of the following:

¥ Click the Contents tab to view lists of topics in the main help 
window.

¥ Click the Index tab to open the Index window and view a list 
of index entries.

¥ Click the Find tab to search for words or phrases that may be 
contained in a help topic.

Finding Topics with the Index

To Þnd topics using keywords in the Index:

1. Click the Index tab to display the Index panel.

2. In the text box, type the keyword youÕre interested in or choose a 
topic from the list.

3. Click the Display button to view the topic or double-click the topic 
name in the Index scrolling list.

Searching with the Find Feature

To search for words in a help Þle:

1. Click the Find tab to display the Find panel.
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2. In the text box, type a word you want to Þnd. Use the pop-up 
menus to change the way in which you search for words.

3. If youÕd like to search for additional words, click the More Choices 
button.

4. Click the Search button. Topics that are found are displayed in the 
list.

5. Choose a topic in the list (if any were found) and click the 
Display button.

n DonÕt type quotes or asterisks in the text boxes.

Using Online Documentation

The Media Composer Products Online Publications are a collection of 
books on CD-ROM. They include:

¥ Avid Film Composer UserÕs Guide

¥ Avid Media Composer UserÕs Guide

¥ Avid Media Station UserÕs Guide

¥ Avid Media Composer and Film Composer Effects Guide

¥ Avid Media Composer Products Reference

The books are in PDF format. You can read them on the screen or print 
out all or part of them.
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CHAPTER 2

About Media Composer

This chapter provides a general overview of Media ComposerÕs capa-
bilities. It introduces basic concepts along with some tips for the begin-
ning user in the following sections:

¥ About Media Composer

¥ Editing Basics

¥ Project Workßow

About Media Composer

Media Composer streamlines the editing process by combining the 
traditional tools of postproduction, the creative control of digital edit-
ing, and the simplicity of the interface.

More than a method of saving time and money, nonlinear editing 
introduces a whole new style of craftsmanship into the postproduction 
suite by allowing greater experimentation in the composition of full-
motion visual media.

In addition, Media Composer blends the traditional beneÞts of previ-
sualization familiar to the conventional ofßine editor with the 
advanced production tools and image quality of high-end online pro-
duction.
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Editing Basics

The unique nature of nonlinear editing Ñ and the speciÞc features of 
the Media Composer system Ñ suggest a new way of approaching the 
process of editing and the ßow of your work on projects, as described 
in this section.

About Nonlinear Editing

As a digital, nonlinear editing tool, Media Composer provides com-
plete random access to footage, with instantaneous cueing and retrieval 
of sequences, segments, shots, and frames. This is much faster than the 
time it would take to mount and shuttle through tapes.

In addition, traditional editing requires that you electronically copy 
video from a source tape to a master tape. When you make changes in 
this linear arrangement, you must reassemble all of the shots that fol-
low the change. By contrast, when you edit with Media Composer, 
you are not actually cutting or dubbing the footage. Instead, your  
source tapes are digitized into media Þles that can be played just like 
the original tapes. When you edit, you work with these images and 
sounds (objects) with great freedom, creating data Þles that refer to the 
media Þles and to your original source tapes. You can make changes, 
and the entire sequence is immediately updated. This is the primary 
beneÞt of nonlinear editing.

The system maintains frame-accurate links between each alteration of 
the objects you work with and the original media Þles. This allows you 
to experiment with every edit you make through multiple generations. 
When you play back your work, the system immediately accesses and 
plays the appropriate portions of the digitized video and audio.

You can use Media Composer to create:

¥  A Þnal product based on the media Þles

¥ A work print as a reference to editing tapes
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¥ An edit decision list (EDL) that you can use to control the editing 
of tapes in an online or ofßine editing studio

Editing Components

Knowing some basic terms for the editing components will help you 
use Media Composer more effectively.

¥ Project: the job that results in one or more sequences; the Project 
window organizes all the clips, sequences, effects, and media Þle 
pointers for a program or series of programs

¥ Sequence: an edited composition that includes audio and video 
clips and rendered effects connected

¥ Bin: the window in which you organize the material to be edited

¥ Source clip: the smallest media object that contains all the infor-
mation necessary to reference footage

¥ Master clip: editing object that references the compressed media

¥ Media Þle: stored, compressed digital data representing the origi-
nal video and audio

¥ Source/Record mode: a mode composed of a Source monitor that 
displays source clips, a Record monitor that displays the assem-
bled sequence, and controls for making basic edits

¥ Timeline: the graphical representation of every edit made to a 
sequence, including all nested effects and layered tracks

¥ Segment mode: editing controls for moving, deleting, marking, 
and editing segments in the Timeline

¥ Trim mode: controls for Þne-tuning edits and transitions with var-
ious trim procedures

¥ Effect mode: controls in the Timeline and the Effect Mode window 
to apply, render, and edit effects into the sequence

¥ IN and OUT point: starting and ending points of an edit



37

¥ Subclip: Part of a master clip, which references the master clip

¥ EDL: edit decision list containing detailed information on your 
sequence for online editing of a videotape master

¥ Cut list:  a series of output lists containing speciÞcations used to 
conform the Þlm work print or negative

¥ Digital cut: a copy struck directly from disk to tape

Project Workflow 

The following sections introduce the four basic stages of a project, 
along with the basic system terms you encounter in Media Composer. 
Complete procedures for each phase are described in this guide, in the 
Avid Composer system online help, and the Avid Media Composer 
UserÕs Guide. You can alter parts of each stage if necessary.
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Starting a Project

Starting a project involves the following steps:

1. Turn on your equip-
ment in a prescribed 
order and launch the 
Media Composer soft-
ware.

2. Select or create a new 
project: the job that will 
result in one or more 
Þnished sequences.

3. Create and organize 
bins.

4. Back up your project 
on a regular basis.

Turn on and launch Media Composer.

Select or create a project.

Create and organize bins.

Back up the project.
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Preparing to Edit

Preparing to edit involves the following procedures:

1. Import your logs into 
the bins, or log the 
material manually to 
create source clips.

2. Digitize your analog 
footage, creating media 
Þles and master clips.

3. Work with bins and 
clips to organize your 
source material for easy 
access during editing.

4. Build a storyboard, if 
desired, to begin previ-
sualizing your Þnal cut 
before editing.

5. Manage media Þles 
using controls pro-
vided by the system, 
such as the Media Tool.

Sourcelog

tapes

 Import shot logs into the bin.
Digitize footage, creating

Sort and organize clips in bins.

 Previsualize with storyboards.

master clips and media files.

Manage media files for storage,
efficiency, and backup security.

1.

2.

3.

4. 5.
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Editing a Sequence

Editing a sequence involves the following procedures:

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
in Source/Record 
mode, which provides 
nonlinear editing con-
trols with Source and 
Record monitors, and 
the Timeline.

3. Fine-tune your edits 
and effects using func-
tions of the various edit 
modes, such as Segment 
mode, Trim mode, and 
Effect mode.

4. Adjust and mix mul-
tiple audio tracks and 
prepare for Þnal play-
back or output using 
Media ComposerÕs 
Audio Tool and Audio 
Mix Tool.

5. Return to editing if 
further adjustments are 
required.

Screen, mark, and subcatalog footage.

Edit in Source/Record mode and the Timeline.

Fine-tune edits and effects.

Fine-tune audio pan, volume, and EQ.

Screen and continue
editing as necessary.

monitormonitor

Timeline

Source Record
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Generating Output

Generating various forms of output based on your sequence involves 
selecting among several options:

¥ Export and exchange 
material for audio 
sweetening or graphics 
enhancement in a third-
party application, or 
for incorporating into a 
multimedia project.

¥ Record the Þnal 
sequence as a digital 
cut.

¥ Generate an EDL.

EDL

Beta-
cam

Export and exchange material for import into 
third-party applications such as AudioVision.

Record a digital cut directly to tape.

Generate an EDL for online
videotape editing.
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CHAPTER 3

Starting a Project

The Project window provides controls in three different display modes 
for structuring and viewing important information about your current 
project. These include a display of bins and folders associated with the 
project, a list of all settings, and basic information about the format of 
the project and use of system memory.

The overview topics are described in the following sections:

¥ About Composer Projects and Avid Users Folders

¥ Using the Bins Display

¥ Using the Settings Display

¥ Using the Info Display

Tutorial: Starting a Project contains the following sections:

¥ Starting the Application

¥ Opening a Project
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About Composer Projects and Avid Users Folders

Composer Projects and Avid Users folders allow you to move whole 
projects or selected project and/or user settings between systems by 
copying and moving Þles on your desktop.

When you create a new project or user, the system creates the follow-
ing Þles and folders:

¥ When you create a new user, the system creates three items: a user 
proÞle Þle, a User settings Þle, and a user folder containing the 
two. Each item is given the user name you provide. This new 
folder is stored in the Avid Users folder on the Avid drive.

¥ When you create a new project, the system creates three items: a 
project Þle, a Project settings Þle, and a folder containing the two, 
each of which is given the project name you provide. This new 
folder is stored in the Composer Projects folder on the Avid drive.

Your settings are initially set to the default values. As you work, the 
Þles maintain current settings, while the project folder Þlls with bin 
Þles.
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Using the Bins Display

Bins are windows that contain titles, Òthumbnails,Ó and information 
about the material you digitize. These editable Þles are called master 
clips. They refer to the actual media Þles created when you digitize 
source material. While the physical media are stored on external hard 
drives, the master clips that refer to that media reside in the bin. Bins 
also store the sequences, subclips, group clips, and effect clips that you 
create during a project. The Project window allows you to make a new 
bin, close it, reopen it, and move clips among these bins. You can also 
open bins created for different projects.

After you select a user and project in the Project Selection dialog box, 
the Project window opens. To view a complete list of bins associated 
with the project, click the Bins button in the Project window. A scroll-
ing list appears.

From the Bins list you can examine the number, names, size, and loca-
tion of bins, and you can also open bins. Dotted bin icons next to bin 
names indicate bins that are currently open; solid icons indicate closed 
bins.

Bins button

Open bin
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Using the Settings Display

From the Settings display you can view, select, open, and alter various 
User, Project, and Site settings, as described in this section.

To view the Settings display, click the Settings button in the Project 
window. A scrolling list of settings appears.

About Settings

Three types of settings are displayed in the Settings scroll list, as indi-
cated in the third column of information: User, Project, and Site 
settings.

¥ User settings are speciÞc to a particular editor. In general, User 
settings reßect individual preferences for adjusting the user inter-
face in Media Composer. Individual User settings are stored in 
each user folder within the Avid Users folder on the Avid hard 
drive.

¥ Project settings are directly related to individual projects. When a 
Project setting is changed, it affects all editors working on the 
project. SpeciÞc Project settings are stored in each project folder 
within the Composer Projects folder on the Avid hard drive.

Settings button

Settings type
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¥ Site settings establish default parameters for all new users and 
projects on a particular system. These can apply to particular con-
Þgurations of equipment installed at the site, for example, spec 
and node settings for an external switcher. They can also include 
other user or project settings that you copy into the Site Settings 
window. Site settings are stored in a separate Settings folder in the 
Media Composer folder on the Avid hard drive.

¥ Workspace settings let you associate a conÞguration of windows 
with a workspace setting name. If you are used to working with a 
particular group of windows arranged and sized in a particular 
setup, you can assign a Workspace setting to remember that 
arrangement. You can have as many workspace settings as you 
want. See the Avid Media Composer UserÕs Guide  and ÒWorkspace, 
selectingÓ in the online help index for more information.

Reviewing Basic Settings

For a complete descrip-
tion of all settings and 
their options, see the 
Avid Media Composer 
Products Reference.

The following list describes basic system settings to review at the start 
of your project:

¥ Bin settings

¥ General settings

¥ Interface settings

Double-click each setting in the Settings scroll list of the Project win-
dow to view the following dialog boxes:

¥ Bin settings deÞne general system functions related to bins, 
including:

- Parameters of the Auto-save function

- Maximum number of bin backup Þles stored in the Attic 
folder 

¥ General settings deÞne fundamental system defaults, including:

- Starting timecode for sequences edited in Media Composer
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- Setup default for either American NTSC or Japanese NTSC 
video input (affects calibration)

- Whether the system uses the drive-Þltering function to auto-
matically target only the fastest drives when digitizing high-
resolution media

¥ Interface settings determine the level of basic information dis-
played in the interface, including whether written labels are dis-
played beneath icons in the various command palettes.

Using the Info Display

The Info display in the Project window allows you to view basic 
project information, such as the video format (NTSC, for example) or 
frame rate (24 fps for Þlm projects).

To activate the Info display, click the Info button in the Project 
window.

The items listed in this view are for information only and cannot be 
changed from the Info list.

To see additional information:

1. Click the Fast Menu button at the bottom of the Info window.

Info button

Fast Menu button
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A pop-up menu appears.

2. Choose one of the options from the pop-up menu. See the Avid 
Media Composer UserÕs Guide  or ÒInfo display of project informa-
tionÓ in the online help index for more information about these 
options.

About Projects and Memory

The way in which a project uses memory has a direct effect on perfor-
mance. As a project develops, the number of media objects in use 
(clips, effects, and other bin items) increases. Because the system keeps 
track of them in RAM, they can be played back faster, but the memory 
requirements can slow down the system in other ways.

The Avid Media Composer and Film Composer Release Notes provide infor-
mation about system requirements for RAM. Occasionally you might 
need to adjust the way your Macintosh uses its RAM in order to work 
efÞciently. There are two factors that can affect the performance of 
your system:

¥ If you opened and quit several applications during a session, or if 
you opened and closed various Media Composer tools repeatedly, 
your computerÕs memory may become fragmented. As a result 
your system may be sluggish. To solve this problem, close all 
applications and restart your Macintosh.

¥ If you need to open more or larger Þles within Media Composer, 
you might want to increase the amount of memory allocated to the 
application from the desktop.

n To check and adjust the allocation of system memory (RAM), consult your 
Macintosh documentation.
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Viewing Memory

To view how your Avid Composer system is using the system mem-
ory, press kÐI on the keyboard or choose Memory from the Info win-
dow Fast menu. Also see the Avid Media Composer and Film Composer 
Release Notes for information about memory requirements.

If the memory in use is already near the limit of the total memory, you 
might want to consolidate Þnished elements and eliminate old mate-
rial from the project, or break the project up into separate, segmented 
projects. For more information on consolidating, see the Avid Media 
Composer UserÕs Guide.
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Tutorial: Starting a Project

In this tutorial, you will start Media Composer and select a user and a 
project. Before starting this procedure, make sure you have installed 
the Tutorial Þles (see ÒInstalling the Media Composer Tutorial FilesÓ 
on page 25).

Starting the Application
1. Double-click the desktop alias of the Media Composer folder icon 

to open the folder.

2. Double-click the Media Composer application icon to launch the 
program.

After a few moments, the Project Selection dialog box appears.



51

For this tutorial, you use the Boat Shop project (along with its set-
tings Þle) that you copied into the Composer Projects folder in 
Chapter 1.

Opening a Project

To open a project, you create a new user and select an existing project.

Creating a User

To create a new user:

1. Click the New User button.

A dialog box appears.

2. Type your name and click OK. 

The Project Selection dialog box reappears with your name high-
lighted in the list of users.

Selecting a Project

To select a project:

1. Select Boat Shop from the Composer Projects list and click OK.
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The Project window opens. It lists the bins, or storage areas, cre-
ated to hold the clips and sequences you will need for this tutorial. 

2. Double-click the icon to the left of Getting Ready to Edit to open 
the bin.

This bin contains the clips of the source footage you will use to 
begin to build the Boat Shop sequence.

YouÕve Þnished this tutorial section. The next section is Tutorial: Get-
ting Ready to Edit on page 76. Be sure to read Chapter 4 and the intro-
ductory material in Chapter 5 before continuing the tutorial.
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CHAPTER 4

Digitizing

This chapter surveys the digitize process and related tools. Topics
 covered include:

¥ Selecting Settings

¥ About the Digitize Tool

¥ About the Audio Tool

¥ About the Video Input Tool

¥ Digitize Preparations Check List

¥ Digitizing
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Selecting Settings

A number of settings have a direct bearing on the digitizing process. 
Before digitizing, review the following options for General Settings, 
Deck Settings, and Digitize Settings.

¥ Drive Filtering Based on Resolution causes the system to dim all 
drives for which speed capabilities are unknown or untested in a 
particular Avid Video Resolution (AVR). This setting is selected by 
default in the General Settings dialog box.

c The Avid Composer system does not prevent you from using non-
Avid drives, but their reliability cannot be assured.

¥ Deck Settings include various options for source deck, sync 
mode, preroll, drop/non-drop-frame preference, and deck control.

¥ Digitize Settings include essential options for digitizing and 
batch-digitizing, including general parameters for capture of the 
source material, and special conditions such as   digitizing across 
timecode breaks or capturing a single video frame.

¥ Deck ConÞguration Settings allow you to establish deck control 
parameters for a single deck or for multiple decks. You can manu-
ally conÞgure the deck or use the AutoconÞgure option.
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About the Digitize Tool

The Digitize Tool provides controls for digitizing your footage.

To open the Digitize Tool, choose Digitize from the Tools menu. The 
Digitize Tool window opens.

The Digitize Tool has the following characteristics:

¥ Track Selection panel lets you choose which audio tracks you 
want to digitize from the source tape, whether you want to digi-
tize video, and whether you want to record timecode.

¥ Bin pop-up menu lets you choose a target bin as the destination 
for the master clips created when you digitize on-the-ßy. You can 
also choose a target bin containing the logged clips you will use to 
batch-digitize your media.

Track Selection

Digitize indicator

Digitize

Subclip
indicator

Trash/
Abort

Deck controls

Message bar

Deck selection Tape name

Target drive

Digitize/Log mode

ResolutionBin

Deck
offline

Record to

Single/Dual
drives

Video Input Tool Audio Tool

 the Timeline

Disk time 
available
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¥ Resolution pop-up menu next to the Bin pop-up menu lets you 
choose an Avid Video Resolution (AVR).

¥ Digitize indicator ßashes on and off while you are digitizing.

¥ Red Digitize button begins the digitizing process.

¥ Digitize/Log mode button lets you switch between digitize mode 
and log mode.

¥ Single/Dual drives button lets you target a single or separate 
media drive volumes for digitizing the audio and video for each 
clip.

¥ Target drive pop-up menu lets you choose the target drive 
volumes.

¥ Disk time available is displayed after you select an AVR and 
target a drive or drives for the digitized media.

¥ Trash/Abort button stops the digitizing process and deletes the 
digitized media.

¥ Status bar displays information on the current status of the tool.

¥ Subclip indicator displays a subclip IN mark, a subclip OUT 
mark, and a clip icon or number. It provides visual feedback when 
you create subclips on-the-ßy while digitizing.

¥ Record to the Timeline allows you to digitize footage directly 
from tape into a sequence loaded in the Timeline in one step. 
Recording to the Timeline works best when you are digitizing on-
the-ßy.

¥ Deck Ofßine button takes the deck ofßine: the software ceases to
 recognize the deck.

¥ Deck controls operate the deck.

¥ Deck selection pop-up menu lets you choose the deck you want 
to play from. It also lets you check and reset serial port connection 
to decks.

¥ Tape name display shows the name of the source tape.
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About the Audio Tool

The Audio Tool controls parameters for incoming audio.

To open the Audio Tool, choose Audio Tool from the Tools menu or 
click the Audio Tool icon in the Digitize Tool window. The Audio Tool 
window opens.

The Audio Tool has the following options:

¥ Input button displays a panel that contains a single slider control 
for raising or lowering global audio input.

¥ Setup button displays a panel that contains information and con-
trols for adjusting various audio hardware parameters.

¥ Reset Peak button resets the current maximum peak measure-
ments. It also stops the playback of the internal calibration tone.

Input

Setup

Reset Peak

Peak/Hold

In/Out toggle

Setup 

Analog VU scaleDigital VU scale

Output
Display Display

Meters

Channel
Selectors
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¥ In/Out buttons toggle the meter displays for each channel 
between input levels from a source device and output levels to the 
speakers and record devices. I indicates input, and O indicates 
Output.

¥ Peak Hold pop-up menu allows you to choose options for cus-
tomizing the meter displays, and setting and playing back the 
internal calibration tone.

¥ Digital VU scale to the left of the meters displays a Þxed range of 
values from 0 to -90 decibels (dB), according to common digital 
peak meter standards.

¥ Analog VU scale to the right of the meters displays a Þxed range 
of values that you can conform to the headroom parameters of 
your source audio.

¥ Meters dynamically track audio levels for each channel as follows:

- Meters show green below the target reference level (the 
default reference level is -14 on the digital scale).

- Meters show yellow for the normal headroom range, above 
the reference level to approximately -3 dB.

- Meters show red for peaks approaching overload, between -3 
dB and 0 (zero) dB.

- Thin green lines at the bottom indicate signals below the dis-
play range.

¥ Channel Selector pop-up menus let you map tracks in the 
sequence to output channels.

About the Video Input Tool

The Video Input Tool controls parameters for incoming video.

To open the Video Input Tool, choose Video Input Tool from the Tools 
menu or click the Video Input Tool icon in the Digitize Tool window. 
The Video Input Tool window opens.
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Click the Internal Waveform Monitor button to bring up the Waveform 
monitor. Click the Vectorscope button to bring up the Vectorscope.

The Video Input Tool has the following options:

¥ Input pop-up menu lets you choose either a Composite or Com-
ponent video input source.

¥ Sliders let you change the value for each setting.

¥ Preset buttons are highlighted when the factory preset levels are 
displayed. When you click a lit Preset button, it turns gray and the 
slider returns to the most recent manual level setting.

¥ Settings pop-up menu lets you save the site settings for an indi-
vidual tape each time you calibrate bars.

¥ Internal Waveform monitor lets you adjust luminance values.

¥ Vectorscope monitor lets you adjust hue and saturation.

Input

Vectorscope Vectorscope
button

Internal
Waveform
Monitor

Internal
waveform
monitor

Settings

Preset
buttons

Slider

button
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Digitize Preparations Check List

1. Check your hardware conÞgurations: power switches, cable con-
nections, pull-down switch on the Video Slave Driver, and remote 
switch on the source deck for deck control (see the Avid Media 
Composer Products Setup Guide for hardware conÞgurations).

2. In the Project Settings scrolling list, make sure you have the 
desired options selected in the General Settings, Deck Settings, 
Deck Preferences, Deck ConÞguration, and Digitize Settings dia-
log boxes.

3. Consider striping your drives in advance according to the 
AVIDdrive Utility UserÕs Guide if you are working on a complex 
project with multiple streams of video and high-resolution 
images. You must stripe your drives if you work with AVR

4. Insert a tape into the deck and set up the Digitize Tool for track 
selection, target bin, target drives, source tape, and source deck.

5. Set up the Compression Tool for resolution (AVR) and color 
compression (see the Avid Media Composer UserÕs Guide and ÒCom-
pression ToolÓ in the online help index for more 
information).

6. Use the Audio Input Tool to set the audio input levels.

7. Use the Video Input Tool to set the video input levels; save your 
video settings for future use.
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Digitizing

You can digitize your source material in one of the following ways:

¥ Digitize and log at the same time

¥ Batch digitize

¥ Redigitize

¥ Use Avid MediaLog and import shot logs

Digitizing and Logging at the Same Time

When you digitize without entering log information in a bin ahead of 
time, the system creates clips and associated media Þles while you dig-
itize. Digitizing in this manner involves manually cueing source foot-
age with an Avid-controlled deck using the deck controls in the 
Digitize Tool.

See ÒDigitizingÓ in the  
online help index for 
more information.

There are several ways to digitize and log at the same time:

¥ Digitizing from a mark IN to a mark OUT. This method lets you 
specify the exact timecode location to begin and end digitizing. 
You can also specify only a mark IN or mark OUT, and enter the 
other mark on-the-ßy.

¥ Digitizing on-the-ßy. This method is easier than setting marks, 
but it is more imprecise. It involves using the deck controls in the 
lower left corner of the Digitize Tool to cue, play, and stop the 
source footage manually while digitizing.

¥ Autodigitizing. This method requires the least amount of supervi-
sion and effort, but usually calls for more digitizing time and disk 
storage space. It involves playing each source tape from a cue 
point near the beginning and letting the system digitize the entire 
tape, automatically naming and entering each long clip into the 
bin.
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Batch Digitizing

Once you have imported a log or manually logged a group of clips 
into a bin, you can automate the digitize process by using your Avid 
Composer systemÕs batch digitizing capabilities. In order to batch dig-
itize, source tapes must have timecode. For more information and pro-
cedures, see ÒBatch digitizingÓ in the online help index.

Redigitizing

Redigitizing is the process of capturing previously digitized source 
footage based on existing clips and sequences. Redigitizing uses the 
batch digitize process and does not require extra logging time because 
the clip information for such things as source tracks, timecodes, and 
compression settings already exists in the bin. For more information 
and procedures, see ÒRedigitizingÓ in the online help index.
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CHAPTER 5

Getting Ready to Edit

To get ready to edit, you need to understand how to organize your 
clips and manipulate them. The overview is in the following sections:

¥ About Bin Display Modes

¥ About Bin Views

¥ Controlling Playback

¥ Marking IN and OUT Points

¥ Creating Subclips

Tutorial: Getting Ready to Edit contains the following sections:

¥ Viewing Clips

¥ Playing Clips

¥ Marking Edit Points

¥ Subclipping
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About Bin Display Modes

You can use three display modes for viewing and working with clips 
in a bin: Text mode, Frame mode, and Script mode.

¥ In Text mode, clips are displayed in a database text format using 
columns and rows, with icons representing the various objects. 
You can save various arrangements of columns, text, and objects 
as customized views by using the Bins settings in the Project win-
dow and the Bin Fast menu.

To enter Text mode, click the Text Mode button (labeled T) in the 
lower left portion of the bin.

¥ In Frame mode, each clip is represented by a single picture frame, 
with the name of the clip. You can play back the footage in each 
frame, change the size of frames, and rearrange frames in any 
order within the bin.

Column headings

Object icons

Bin view menu

Text mode

Bin Fast menu

Frame mode

Script mode
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To enter Frame mode, click the Frame Mode button (labeled F) in 
the lower left border of the bin.

¥ In Script mode, the system combines the features of Text mode with 
Frame mode, and adds space for typing notes or script. The frames 
are displayed vertically on the left side of your screen with a text 
box to the right of each clip. Clip data is displayed above the text 
box.
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To enter Script mode, click the Script Mode button (labeled S) in 
the lower left portion of the bin.

About Bin Views

To the right of the Display Mode buttons is a pop-up menu of titles for 
different Bin views. This option is available only in Text mode. Bins 
have the following default views that are automatically loaded:

¥ Statistics view uses the standard statistical column headings 
derived from information established during capture, such as 
Start and End timecodes, Duration, Resolution, and so on.

¥ Custom view allows you to create and save customized views. 
The only required heading is the clip name, displayed by default. 
You can customize the view by adding, hiding, or rearranging col-
umn headings.

Controlling Playback

There are several ways to play, view, and cue clips:

¥ Instantly access frames or move through footage using the position 
indicator within the position bar under the Source or Record moni-
tors

¥ Play, step (jog), or shuttle through footage using user-selectable 
buttons

¥ Play, step, or shuttle using keyboard equivalents

¥ Step or shuttle using the mouse
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Using Position Bars and Position Indicators

You can quickly access frames within a clip thatÕs been loaded into a 
monitor or move through the footage using the position indicators 
that appear in the position bars under Source or Record monitors, and 
in the Timeline when you are viewing a sequence.

¥ You can move the position indicator within the position bar under 
the Source or Record monitors by clicking anywhere in the posi-
tion bar, or by dragging the position indicator to the left or right. 
The speed with which you drag the position indicator determines 
the speed at which you move through the footage.

¥ In the Timeline, the position indicator shows your position within 
the sequence. It is always in the same position as the position indi-
cator in the Record monitorÕs position bar, and works in the same 
way: you can click anywhere in the Timeline to relocate the posi-
tion indicator, or you can drag the position indicator through foot-
age at varying speeds.

¥ You can go directly to the beginning or end of a clip or sequence 
by clicking at the far left or far right of the clip or sequence.

Position bar

Position indicator

Position indicator in Timeline
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Using Buttons

You can use the user-selectable buttons that appear below the Source 
and Record monitors to play and step through your footage. You can 
also use the keyboard to manipulate footage.

Aside from the default conÞgurations, these buttons can be remapped 
from the Command Palette in any conÞguration onto any of the user 
palettes and the keyboard.

Play, Pause, Stop, Fast Forward, and Rewind Buttons

The Play, Pause, Stop, Fast Forward, and Rewind buttons work much 
like the buttons on any conventional VCR. With a clip loaded in a 
monitor, the Play button plays your footage at a normal rate. The Play 
Reverse button plays backward at a normal rate. The Fast Forward 
and Rewind buttons instantly cue you to the beginning or the end of 
the clip.

Play, Fast Forward, and Rewind buttons appear by default in the Þrst 
row of buttons below the Source and Record monitors. Map the Play 
Reverse, Stop, and Pause buttons onto your button rows from the 
Command Palette. Mapping replaces the existing button functions.

n During playback, the Play button also acts as a Stop button.

When viewing sequences in the Record monitor, you can play only 
video and audio tracks that are currently monitored in the Track Selec-
tor panel.

Track Selector panel

Video Monitor buttons

Audio Monitor buttons
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To play a clip:

1. Load a clip or sequence into a monitor.

2. For sequences in the Record monitor, click the Video or Audio 
Monitor buttons in the Track Selector panel.

3. Go to the start of the clip or sequence by clicking the start of the 
position bar under the monitor, or pressing the Home key.

4. To play the clip or sequence, click the Play button under the cho-
sen monitor.

5. To stop playback, press the space bar or click the Play button 
again.

Step Buttons

You can also use the Step buttons under the monitors to play the clip 
backward or forward in 1- or 10-frame increments.

When you have a single row of buttons displayed under your moni-
tors, the Step Forward and Step Backward buttons appear. If you press 
and hold the Option key while clicking either button, you can advance 
ten frames forward and ten frames backward.

n To display all four Step buttons, you must display two rows of buttons under 
the monitors when conÞguring the Source/Record window in the Composer 
Settings dialog box.

To step through footage:

1. Load a clip or sequence into a monitor.

2. Press the appropriate key to step one or ten frames forward or 
back.
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Using the Keyboard

The default keyboard contains all of the buttons discussed so far.

n You can move and replace buttons on the keyboard using the  Command Pal-
ette; see  ÒUser-selectable buttons, mappingÓ in the online help index.

J-K-L Keys (Three-Button Play)

The J-K-L keys on the keyboard allow you to play, step, and shuttle 
through footage at varying speeds. This feature, also referred to as 
three-button or variable-speed play, allows you to use three Þngers to 
manipulate the speed of playback for greater control.

To shuttle through the footage using the J-K-L keys on the keyboard:

1. Do one of the following:

¥ Load a clip or sequence into the Source or Record monitor.

¥ Select a clip in a bin in Frame mode.

Play button

Stop button

Play/Step/Shuttle buttonsStep buttons Home key
End key
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2. Use the following keys to shuttle at varying speeds:

¥ Press the L key to move forward through the footage at nor-
mal speed. Press once to increase the forward speed 2 times, 
twice to increase it 4 times, and 3 times to increase it 8 times 
normal speed, as desired.

¥ Press the J key to move backward at the same shuttle speed 
increments.

¥ Hold and press the K and L keys together for slow forward.

¥ Hold and press the K and J keys together for slow backward.

3. To pause the shuttling, press the K key. 

4. To stop shuttling, press the space bar.

Home, End, and Arrow Keys

You can also use the Home, End, and arrow keys on the keyboard to 
move through footage when a clip is loaded in a monitor.

¥ The Home key takes you to the beginning of a clip or sequence.

¥ The End key takes you to the end of a sequence.

¥ The Left Arrow key moves the footage one frame backward.

¥ The Right Arrow key moves the footage one frame forward.

Using the Mouse

You can also use the mouse for one-handed control of playback. You 
can either step or shuttle by using the mouse.

Stepping with the Mouse

To step by using the mouse:

1. Do one of the following:
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¥ Load a clip into the Source monitor or a sequence into the 
Record monitor.

¥ Select a clip in a bin in Frame mode.

2. Do one of the following:

¥ Press the N key to activate mouse control for stepping.

¥ Activate the buttons on the Command Palette by deselecting 
both boxes at the bottom of the Palette, then click the Mouse 
Step button, which is available on the Play tab of the Com-
mand Palette and can be mapped to any button under the 
Record monitor (see ÒUsing the Command PaletteÓ on 
page 119).

3. Move the mouse to the right to step forward, or to the left to step 
backward.

4. To quit stepping with the mouse, press the space bar.

Shuttling with the Mouse

To shuttle by using the mouse:

1. Do one of the following:

¥ Load a clip or sequence into the Source or Record monitor.

¥ Select a clip in a bin in Frame mode.

2. Do one of the following:

¥ Press the semicolon (;) key to activate mouse control for 
shuttling.

¥ Activate the buttons on the Command Palette by deselecting 
both boxes at the bottom of the Palette, then click the Mouse 
Shuttle button, which appears on the Play tab of the Com-
mand Palette and can be mapped to an editing button under 
the Record monitor (see ÒUsing the Command PaletteÓ on 
page 119).

Mouse Step
button

Mouse Shuttle
button
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3. Move the mouse to the right to increase the shuttle speed, or to the 
left to decrease the shuttle speed.

4. To quit shuttling with the mouse, press the space bar or double-
click the mouse button.

You can also use the keyboard in conjunction with the mouse to con-
trol shuttling. For example, if youÕre shuttling with the mouse and you 
press the L key, the playback speeds up to the next normal play rate 
(30, 60, 120, 240 fps for NTSC; 25, 50, 100, 200 fps for PAL; 24, 48, 96, 
192 for Þlm projects). You can continue to change the shuttle speed 
and direction with the mouse.

Marking IN and OUT Points

You can mark IN and OUT points for your clips in advance, which 
provides several advantages:

¥ You can quickly build a sequence by splicing the marked clips into 
place one after another.

¥ You can use the process of rough-cut or storyboard editing, which 
allows you to instantly splice several prepared clips into a 
sequence, as described in the Avid Media Composer UserÕs Guide. 

¥ You can play back and mark clips in the bin before loading a single 
clip, saving several steps.

Even if your marks are not accurate now, Media Composer allows you 
to trim the edit points and Þne-tune the sequence later without reedit-
ing the material.

Creating Subclips

When you mark footage with IN and OUT points, you can either save 
the entire clip along with the new marks, or you can create subclips 
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based on the marks you set to break up longer master clips into 
smaller segments of selected footage. 

This is similar to creating selects of all your best footage before editing. 
Unlike selects, however, subclips do not directly reference the original 
media. Subclips remain linked to the master clips from which they are 
created, and the master clips in turn reference the digitized media Þles 
located on your storage drives. As a result, none of the original footage 
is lost.

You can also create sub-
clips while digitizing
as described in 
ÒSubclips:creating on-
the-ßyÓ in the online 
help index.

You can create subclips directly from the marked section of material in 
the monitors by using one of the following methods:

¥ Option key: Press and hold the Option key, then drag the picture 
from the monitor to the bin in which you want to store the subclip.

¥ Clip icon: Click the icon next to the clip name in the Source moni-
tor, then drag the icon to the bin in which you want to store the 
subclip.

The clip icon changes to an icon of a frame during the drag, then 
becomes a subclip icon when you release the frame in the intended 
bin.

¥ Subclip button: Click the Subclip button located in one of the 
command palettes to create the subclip and place it into the active 
bin by default. If you press the Option key while you click the Sub-
clip button, a dialog box allows you to choose the destination bin 
for the subclip.

The new subclip will be listed in the bin, preceded by a subclip icon 
and identiÞed with a numbered .Sub sufÞx, as shown in the following 
illustration.

Clip icon
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For more information on trimming, see ÒTrim EditsÓ in the  online help 
index.

Subclips do not limit your access to the original, digitized master clip 
material when trimming. Therefore, if you must trim beyond the 
marked IN to OUT boundaries of the subclip to make it longer or 
shorter, your system does accommodate the boundary adjustments 
during the trim.

A new subclip 
as referenced in 
Bin Text view
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Tutorial: Getting Ready to Edit

The following tutorial steps correspond to the clips and sequence in 
the bin titled Getting Ready to Edit.

n Be sure to read Chapter 2 and the preceding overview sections of this 
chapter before you start this tutorial.

1. If Media Composer is not already running, launch it by double-
clicking the application icon.

2. Choose your User name and your Boat Shop project and click OK.

3. From the Boat Shop Project window, double-click the Getting 
Ready to Edit bin.

The clips associated with the lesson are displayed in the bin.

Viewing Clips

The information in a bin can be viewed in several ways.

¥ Text mode displays columns of information about your clips.

¥ Frame mode displays each clip as a single representative image.

¥ Storyboard mode displays each clip with an image and an area in 
which to enter text as part of a storyboard.
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The S button is for
Script mode. 

LetÕs look at Text mode.

1. Click the Text Mode button (T) in the lower left corner of the bin to 
view information about clips in the Getting Ready to Edit bin.

If the button is dark, you are already in Text mode.

You can rearrange the clips in the bin by sorting on a particular 
column. LetÕs sort by clip name so we can easily locate any clip.

2. Click the Name heading in the bin.

3. Choose Sort from the Bin menu along the top of the screen.

The clipsÕ names are rearranged in alphabetical order.

n To sort in numerical order, select another heading, for example, duration.

Now letÕs look at Frame mode.

1. Click the Frame Mode button (F) to see a pictorial representation 
of each clip in the bin.

Text Mode Frame Mode

Zoom box

Text Mode button
Frame Mode button

Name Heading
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n The sorted order of clips does not carry over to Frame mode.

2. Choose Reduce Frame or Enlarge Frame from the Edit menu.

To change frame size at the keyboard, you can also press k-K 
(Reduce Frame) and k-L (Enlarge Frame).

If some clips are now off screen, do one of the following:

¥ Click the zoom box in the upper right corner of the bin
window.

¥ Choose Fill Window from the Bin menu.

¥ Drag the size box in the lower right corner of the bin window. 

3. Click the zoom box in the upper right corner of the bin window 
labeled Getting Ready to Edit.

The bin zooms out to enclose all the clips. However, they might be 
scattered randomly in the bin window. LetÕs Þx that.

4. Choose Fill Window from the Bin menu.

The clips are arranged in neat rows and columns in the bin.

Now you can adjust frame size so the clips are ÒreadableÓ but not 
so large that they wonÕt Þt in the bin window.

Playing Clips

Your Avid Composer system offers a variety of ways to play clips. The 
more you practice the various methods, the more control you will 
have over the editing process.

Playing Clips in the Source Monitor

The Source monitor is a window in which you can play clips.

1. In the Getting Ready to Edit bin, select the clip named bridge by 
double-clicking anywhere in the frame.
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The bridge clip appears in the Source monitor.

2. Press the Home key on the keyboard (between the main keyboard 
and the numeric keypad) to go to the start of the clip.

The End key, just below the Home key, moves the position indica-
tor to the end of the clip.

3. Press the Play (5) key on the keyboard to play the clip at normal 
speed.

4. Press the Play (5) key again (or press the space bar on the key-
board) to stop playback at any point.

5. Press the L key (Play) on the keyboard to play the clip forward at 
normal speed. Press the key repeatedly to play the clip at 60, 90, 
150, and 240 frames per second (fps). 

6. Press the J key (Reverse Play) to play the clip backward at normal 
speed. Press the key repeatedly to play the clip backward at 30, 60, 
90, 150, and 240 frames per second (fps). 

7. Press the K key to stop playback.

8. To move forward or backward at slow speed, press and hold the K 
key while you press and hold the L or J key.
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9. Use the 1, 2, 3, and 4 keys to step through the footage forward or 
backward in 1-frame or 10-frame increments.

Controlling Playback

In the Source monitor, you can use:

¥ Playback control keys

¥ Equivalent buttons below the Source monitor

¥ Blue position indicator to go to a speciÞc position or scroll through 
a clip

1. Double-click the tools clip in the Getting Ready to Edit bin.

The clip appears in the Source monitor.

2. Click the Play button.

You can press the 5 key on the keyboard for the same purpose.

3. Click the Play button again (or press the space bar on the key-
board) to stop playback at any point.

Step ForwardStep Backward

Step Forward  10 Frames 

 Step Backward 10 Frames

PlayStep

Position
indicator

Position
bar

Forward 
Step
Backward
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4. Step through the footage forward or backward in 1-frame and 10-
frame increments using the Step Forward and Step Backward but-
tons under the Source monitor. You can also use the 4, 3, 2, and 1 
keys on your keyboard.

5. Locate the vertical blue position indicator in the position bar in the 
Source monitor.

6. Click to the left of the position indicator to step several frames 
back in the clip.

To step several frames forward, click just to the right of the posi-
tion indicator.

7. Press the Home key to go to the beginning of the clip.

Press the End key or click the Fast Forward key to go the end of 
the clip.

8. Step through the clip by clicking different spots in the position bar.

9. Drag the position indicator to the left, then to the right, to scroll 
through the clip.

Marking Edit Points

Before making your Þrst edit, you can mark the segments of the clips 
you want to use in your sequence. You can mark clips in the Source 
monitor.

In this section, you will:

¥ Mark IN and OUT points in the Source monitor

¥ Locate IN and OUT points by timecode in the Source monitor
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Marking the planing ms Clip

LetÕs Þrst display clips in the Source monitor, and then mark a couple 
of clips you will use when you edit the sequence.

1. Activate the Getting Ready to Edit bin by clicking anywhere in it 
or by choosing Getting Ready to Edit from the Windows menu.

The bar above the active window turns purple.

2. Double-click the planing ms clip to activate it.

The clip name turns pink and the clip appears in the Source
monitor.

3. Play the clip from the head by pressing Home and then the Play 
(5) key, and Þnd the approximate place where the boatbuilder 
begins to plane. Then use the Step Forward and Step Backward (3 
and 4) keys to locate the frame where he starts the Þrst planing 
stroke.

4. Mark an IN point by pressing the Mark IN (I) key.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

5. Step forward two full strokes of the plane.

6. Mark an OUT point by pressing the Mark OUT (O) key.
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Media Composer remembers your IN and OUT points until you 
change them.

Marking the ducks Clip

Now mark the IN and OUT points for the ducks clip. This time, 
instead of using the 5 key, use the J-K-L keys to play the clip.

1. Double-click the ducks clip to activate it.

2. Locate the frame where the second duck enters the right edge of 
the frame behind the duck swimming in the foreground.

Use the 3 and 4 keys to locate the precise frame.

3. Mark an IN point by pressing the I key.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

4. Step forward to locate the Þrst frame where the same duck ßies 
beyond the left edge of the screen.

5. Mark an OUT point by pressing the O key.

A white sawtooth pattern appears on the right edge of the Mark 
OUT frame.

Marking the draw knife cu Clip

LetÕs mark another clip weÕll use in the sequence.

1. Display the draw knife cu in the Source monitor by double-
clicking it in the Getting Ready to Edit bin.

When you edit the sequence, you want to show just three strokes 
of the knife.

2. Place the position indicator around the midpoint of the clip, and 
play forward until just after the Þrst fairly large wood chip falls 
off.



84

Use the Play button (or J-K-L keys) to get close to the frame, and 
then use the Step buttons to locate the frame you want to use as 
your IN point.

3. Mark an IN point by clicking the Mark IN button under the
monitor.

A white sawtooth pattern appears on the left edge of the Mark IN 
frame.

4. Step forward, and locate a frame just after three strokes of the 
knife.

5. Mark an OUT point by clicking the Mark OUT button under the 
monitor.

A white sawtooth appears on the right edge of the Mark OUT 
frame.

Using Timecode to Find a Frame

You can mark IN and OUT points by using timecode as your reference 
point. If you know the timecode for the frame you want to mark, you 
can go to that frame instantly by typing it on the numeric keypad.

In this section, you will use visual cues to mark an IN point, and then 
locate a speciÞc timecode. First, you need to display the appropriate 
timecode information.

1. Double-click the chiseling clip to open it.

2. Place the cursor in the gray title bar area over the timecode infor-
mation displayed above the Source monitor.

3. When the cursor changes to a downward arrow, click to display 
the pop-up menu, then choose TC, V1 (timecode for track V1) 
from the menu. A checkmark means it is already selected.
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The timecode references the frame displayed in the Source 
monitor.

4. Use the Play and Step buttons to locate the frame where the boat-
builder begins one of the Þrst strokes of the chisel.

5. Click the Mark IN button.

6. Read the timecode in the Timecode display at the IN point. Add 15 
frames (13 frames PAL) to the timecode number. (Remember, there 
are 29 frames in a second.)

For example, if the timecode is 04:11:34:15, adding 15 frames gives 
you a result of 04:11:35:00.

7. Type +15 on the numeric keypad on the right side of the keyboard 
and press Enter on the numeric keypad.

As you start typing, a window opens in the middle of the Source 
monitor, showing the numbers you type. When you press Enter, 
the position indicator locates the speciÞed frame.

The Timecode window displays the current number. 

Timecode shows the following:
Hours
Minutes
Seconds
Frames

One second holds 29 frames.
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n To locate frames using the numeric keypad, you must show the appropriate 
timecode in the Timecode display. For example, the timecode display must 
show track V1 to go to a speciÞc frame on the V1 track.

8. Click the Mark OUT button.

Using Frame Offset

Whenever you use the 
numeric keypad, you 
must press Enter after 
typing the number. 

You can also use the numeric keypad to move the position indicator 
forward or backward a speciÞed number of frames, with the frame off-
set feature. LetÕs mark an IN point for the planing cu clip and then use 
frame offset to locate the OUT point.

1. Double-click the planing cu clip to open it.

2. Use the Play and Step buttons to locate the frame where the boat-
builder begins making the Þrst stroke of the plane.

3. Click the Mark IN button.

4. To advance two seconds, type +129 (+124 PAL) in the numeric 
keypad and press Enter. The system inserts the colons for you.

Timecode 
entered

Timecode
display



87

Since Media Composer counts the frame it is parked on, you type 
one frame less than two seconds.

When using frame off-
set, type one frame less 
than the number of 
frames you want to 
advance.

If you want to move back a certain number of frames, type a 
minus sign (Ð) instead of a plus sign (+) in front of the number.

5. Mark that frame as the OUT point.

Subclipping

Now you will copy portions of one clip into shorter clips, called sub-
clips. Subclipping is a great tool for organizing your footage into man-
ageable units.

1. Double-click the tools clip in the Getting Ready to Edit bin.

2. Press the Home key to go to the start of the clip.

3. Scroll through the clip by clicking the Play button or dragging the 
blue position indicator, and notice there are two separate actions 
that can be copied into separate subclips.

4. Mark an IN point when the boatbuilder begins turning the auger 
drill.

5. Mark an OUT point 14 seconds later by typing +1400 in the 
numeric keypad and pressing Enter.

Actually, you have marked an OUT after 14 seconds and 1 frame, 
but thatÕs okay because you need not be so precise here.

6. Click the clip icon next to the clip name in the upper left corner of 
the Source monitor, and drag the icon into the Getting Ready to 
Edit bin.

As you begin dragging, the pointer changes to a hand attached to 
a small box.

A new item called tools.Sub.01 appears in the Getting Ready to 
Edit bin. The subclip has the name of the original clip, followed by 
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Sub.n, where n is the number of times the master clip has been 
cataloged to that bin. The name is highlighted.

7. Type drilling and press Return (or Enter on the numeric keypad) 
to name the subclip.

Clearing IN Points and OUT Points

1. With the tools clip in the Source Monitor, click the Clear Both 
Marks button under the Source monitor to clear IN and OUT 
points.

2. Mark an IN point in the clip when the boatbuilder begins ham-
mering, after he takes a few practice swings.

3. Mark an OUT point at the end of the clip.

4. Press and hold the Option key and drag the clip from the Source 
monitor to the Getting Ready to Edit bin.

The clip name is highlighted in the Getting Ready to Edit bin.

5. Type hammering and press Return (or Enter on the numeric
keypad).

YouÕve Þnished this lesson. You can go on to Tutorial: Rough Cut on 
page 100, or end the session.

Closing the Project

To close the project:

1. Choose Close Bin from the File menu.

The bin closes.

2. Choose Close from the File menu.

The system saves and closes the project. A dialog box appears.
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3. Do one of the following:

¥ Select an existing project.

¥ Create a new one.

¥ Click Quit.

Ending the Session

To end the session:

1. Choose Save Bin or Save All Bins from the File menu.

2. Click in the Project window labeled Boat Shop.

3. Choose Save All from the File menu.

4. Pull down the menu from under the Source monitor name and 
choose Clear monitor.

5. Do one of the following:

¥ Go to the next lesson.

¥ If you are ready to take a break, choose Quit from the File 
menu to leave Media Composer, then click OK in the Quit dia-
log box.

The system returns to the desktop.
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CHAPTER 6

Editing a Rough Cut

Beginning to edit involves moving around in the Avid Composer sys-
tem. This is described in the following sections:

¥ Viewing Methods

¥ Navigating in the Timeline

¥ Displaying Source Material in the Timeline

¥ Using the Track Selector Panel

Tutorial: Rough Cut contains the following sections:

¥ Making the First Edit

¥ Splicing Video into the Sequence
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Viewing Methods

You can work with clips and sequences in several different ways, 
depending upon your needs and preferences. Each method has its 
own uses and advantages, as follows.

¥ Viewing in bins: Frame mode shows you pictorial images of the 
clips in your bins; Text mode shows you the clips listed by name.

¥ Viewing in the Source monitor: You can load clips and sequences 
into the Source monitor to view and mark or subcatalog shots for 
use in a sequence that you build in the Record monitor.

¥ Viewing in the Record monitor: You can load a sequence into the 
Record monitor to view, mark, or modify an existing sequence. 
You can Option-drag a clip or group of clips into the Record moni-
tor to create a sequence.

Record  monitor 
with sequence 
loaded

Source monitor
with clip loaded
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¥ Viewing in pop-up monitors: You can load clips into pop-up 
monitors to view and mark one or several clips simultaneously in 
smaller, movable windows. (Enable a pop-up monitor by selecting 
Opens New Monitor for Clips in the Bin Settings dialog box.)

¥ Viewing in the Timeline: Use the Timeline to view individual 
tracks for either a sequence or a source clip.

¥ Viewing in full-screen: You can use the third, full-screen monitor 
to view your footage in a larger screen format.

Two pop-up 
monitors with 
clips loaded

Timeline in 
Source mode 
for viewing 
tracks
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Navigating in the Timeline

The Timeline window provides various controls for quickly moving 
through a sequence and adjusting your view of details displayed in 
the tracks while editing. You can make changes in the Timeline format 
by using the Timeline Fast menu or choosing Timeline in the Bin 
settings scrolling list.

Using the Position Indicator

The position indicator (the vertical blue line) in the Timeline marks 
your place in the sequence. It also determines how some of your com-
mands are interpreted. For example, when you perform an edit, the 
system takes the location of the position indicator as the Mark IN in 
the absence of established marks.

When you move the position indicator in the Timeline, the smaller 
position indicator within the Record monitorÕs position bar also 
moves.

Using the Timeline Scroll Bar

The scroll bar functions like any standard Macintosh scroll bar. You 
can drag the scroll box to reposition yourself within the Timeline, or 
click the arrows to scroll left or right.

Scroll box Scroll bar
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Displaying More or Less Detail

The scale box on the scale bar stretches and contracts the Timeline area 
centered around the blue position bar, allowing you to either zoom in 
to focus on a speciÞc area of your sequence, or zoom out for you to see 
your whole sequence. This is especially useful when you have a 
lengthy sequence with many edits.

The Timeline always expands or contracts proportionally on both 
sides of the position indicator.

¥ To see more detail, click and drag the scale box to the right.

As the Timeline expands, a second ÒshadowÓ position indicator 
appears next to the blue position indicator showing the end of a 
single frame, and the two continue to move apart as you expand 
the Timeline.

The position indicator and its shadow mark the beginning and 
end of each frame. The solid bar is the mark or edit point. You can 
click on either the bar or the shadow to move exactly one frame 
forward or backward.

In addition, the Timeline will split in half (or thirds) as it wraps 
through the sequence for you to see all the clips.

¥ To contract an expanded Timeline to see less detail but more of the 
sequence, click and drag the scale box to the left.

Scale box Scale bar

As Timeline expands, a 
shadow position indica-
tor appears
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Focusing the Timeline

Another alternative to the scroll and scale functions is the Focus 
button.

The Focus button allows you to center the position indicator quickly 
and expand the Timeline. Unlike the scroll and scale functions, the 
Focus button expands the Timeline to one frame per four pixels. The 
position indicator is centered in the window. When you click the Focus 
button a second time, it always returns the Timeline to its previous 
size.

Displaying Source Material in the Timeline

The Source/Record toggle button allows you to view a Timeline of the  
clips in the Source monitor. This is especially useful if you are editing 
multitrack effects.

By default, the Timeline displays only the source materialÕs tracks.

When you click the button to display the source material, both the but-
ton and the position indicator turn green to indicate that you are view-
ing source material.

Focus

Source tracks

Source/Record toggle 
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This feature is particularly useful when you are editing a sequence or a 
subclip created from a sequence; you can also use it to look at the con-
tents of any source clip in a Timeline display.

n Heads or Tails views are disabled when you are displaying material from the 
Source monitor.

Using the Track Selector Panel

The Track Selector panel provides numerous controls for working 
effectively with multiple tracks. With this one resource you can select, 
delete, monitor, enlarge, reduce, lock, patch, and move any video or 
audio track.

The Track Selector panel also provides a quick display of track infor-
mation. You can see which tracks (on the source or record side) are 
available, active, patched, monitored, or locked. The conÞguration 
shown below is just one example. The Track Selector panel may look 
very different depending on the nature of the source material or the 
work underway in the sequence.

Button and position indicator 
turn green
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The source side (left side) of the panel displays only those tracks avail-
able for the clip currently loaded and displayed in the Source monitor. 
For instance, a clip that has audio digitized for track A1 only does not 
display an A2 track in the Track Selector panel.

The record side of the panel displays only those tracks currently in use 
for the sequence. However, if you edit source material with a track 
selected that does not yet exist on the record side (A3 or V2, in the pre-
vious example), by default the track appears on the record side after 
the edit takes place.

A clip (or sequence) needs to be loaded in the Source and Record mon-
itors to display both track panels.

Selecting Tracks

You can select tracks on either the record side or the source side as fol-
lows:

¥ You can edit selected tracks on the source side directly into the 
sequence, assuming you have selected parallel tracks on the 
record side.

¥ You cannot edit deselected tracks on the source side into the 
sequence, regardless of record track selections.

Source track monitors
Source tracks
Track lock indicators
Record tracks
Record track monitors

Timecode track
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¥ You cannot edit deselected tracks on the record side, regardless of 
source track selections.

There are four methods for selecting tracks:

¥ Click any deactivated Track Selector button to select it. Click any 
activated Track Selector button to deselect it.

¥ Drag a lasso around multiple Track Selector buttons to select them 
at once.

¥ With the Timeline window active, choose Select All Tracks from 
the Edit menu to select all tracks on the record and source side.

¥ Click the Cycle Picture/Sound button on the Command Palette to 
cycle among selection of the video tracks, the audio tracks, and all 
tracks.

For example, you might select the source and record tracks for V1, A1, 
and A2 to edit video and audio from the source clip into the sequence. 
Select only V1 source and record tracks to edit the video without 
sound. Or, select only A1 and A2 to edit the sound without the video.

n Selected tracks change color.

n There are also keyboard equivalents for selecting tracks. Check your keyboard 
or the Keyboard settings in the Project window Settings scroll list.

Monitoring Tracks

You determine the monitoring of tracks by clicking the monitor col-
umn of either the source- or record-side tracks to activate or deactivate 
the monitor icons. Video and audio monitors behave differently in 
some circumstances, as described in this section.
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Monitoring Video

The video track monitor determines whether you see video during 
playback. You can turn it off at any time to monitor only audio during 
editing. When there are multiple video tracks, all tracks below the 
monitored track are active during playback.

When you edit with multiple tracks, you can activate the monitor on a 
lower track to monitor only the video on that track. This is especially 
useful when you have multiple layers of video effects, and need to see 
one track without the additional layers.

n If you reposition the video monitor, be sure to return it to the topmost track to 
view, render, or record all the tracks together. Unmonitored tracks are not 
included in playback.

Video track monitors

Audio track
monitor

Audio track
monitor
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Tutorial: Rough Cut

In this tutorial you begin editing the Boat Shop sequence. This section 
corresponds to the clips and sequence in the bin titled Rough Cut.

n Be sure to read the preceding overview sections of this chapter before you start 
this tutorial.

Table 6-1 Starting the Tutorial: Rough Cut

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the Rough 
Cut bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the sequence you were 
working on from the previous 
tutorial into the Rough Cut 
bin. Close the Getting Ready 
to Edit bin.

2. From the Boat Shop Project 
window double-click the Get-
ting Ready to Edit bin and the 
Rough Cut bin to open them.

2. Click and drag the Rough Cut 
Sequence clip into the Com-
poser monitor to begin the 
tutorial.

3. Drag the sequence you 
were working on from the 
Rough Cut bin into the Com-
poser monitor.

3. Press the Option key and drag 
the sequence you were working 
on from the previous tutorial 
into the Rough Cut bin. Close 
the Getting Ready to Edit bin.

4. Drag the sequence you were 
working on from the Rough Cut 
bin into the Composer monitor.



101

Making the First Edit

In this section, you lay down the audio clip, which contains the 
sequenceÕs music and narration. You learn how to mark exactly one 
minute of the clip, which will be the duration of your Þnished 
sequence. First, you play the clip.

1. Double-click the Audio Track clip and play the clip in the Source 
monitor.

The clip displays as black because itÕs audio only.

2. Go to the head of the clip by pressing the Home key on your key-
board or clicking the Rewind button under the Source monitor.

Using Digital Audio Scrub

Digital audio scrub is used to locate a speciÞc frame of audio. Use it 
now to locate the Þrst frame of music in the audio clip.

1. Press the Caps Lock key to activate digital audio scrub.

2. Play the clip again and click the Play button to stop at the approxi-
mate place where the music begins.

3. Press the Step (jog) keys (1, 2, 3, 4 on the keyboard) to locate the 
Þrst frame of the music and click the Mark IN button.

When you use the Step keys, a frame of music or speech sounds 
scratchy or buzzlike. You might want to increase the volume of 
your speakers to hear the Þrst frame of music.

4. Press the End key on the keyboard.

5. Press the Step Backward key to Þnd the last frame of music. 

6. Mark that frame as the OUT point.

7. Press the Caps Lock key again to exit digital audio scrub.
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Splicing an Audio Clip

Click the yellow Splice-in button between the Source and Record 
monitors control panel to copy the clip into the Record monitor.

If no points are selected, 
the entire clip is edited 
into the Timeline.

The clip is edited onto track A1 of the Timeline. The Þrst frame is 
the IN point you marked in the clip; the last frame is the OUT 
point you marked in the clip.

The audio track appears in the Timeline. The sequence also 
appears in the Record monitor (the audio track appears black).

Playing a Sequence

The Rough Cut bin contains your newly created sequence. By default, 
Media Composer names it Untitled Sequence.01. LetÕs change this 
name.

1. Click the name Untitled Sequence.01 to select it; do not click the 
sequence icon.

The name is highlighted in black and has a box around it.

2. Type Boat Shop Cut and press Return.

Yellow
Splice-in



103

3. Click the position bar beneath the Record monitor or anywhere 
near the left side of the Timeline, then click the Play button to play 
the audio.

This audio track should run the length of the sequence, and its 
duration should be approximately one minute.

Confirming the Duration

The next steps explain how to conÞrm the duration by displaying the 
master timecode, which is the timecode of your sequence.

1. If Master timecode is not displayed, click and pull down the Time-
code display from the gray area above the Record monitor and 
select Mas (Master) timecode.

The master timecode displays the location of the position indicator 
in your sequence.

2. Move the position indicator in the Timeline or the Record monitor 
to the last frame of the sequence.

The master timecode should read approximately 01:01:00:00.

Splicing Video into the Sequence

Now weÕll start laying some video over the audio. For the opening 
shot in the sequence, use the bridge clip.

1. From the Rough Cut bin, double-click the bridge clip to display it 
in the Source monitor.

Play the whole clip 
through once Þrst to get 
a sense of the material.

2. Mark an IN point midway through the clip, about 2 seconds after 
the camera begins to pan left. Watch the timecode at the top of the 
Source monitor to determine 2 seconds after the camera pans left.

3. Mark an OUT point 3 seconds and 6 frames (5 frames PAL) later, at 
approximately 01:13:43:23.

Audio
Monitor
button

The Audio Monitor
button appears when a 
speaker is activated.
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n If you do not mark an IN point and OUT point, the entire clip will be edited 
into the sequence.

4. Move the position indicator in the Timeline or Record monitor to 
the head of the sequence. 

5. Deselect record track A1.

A track changes color when it is selected; it is gray when it is
deselected.

6. Press the Splice-in (V) key on the keyboard or click the Splice-in 
button under the Source monitor.

The bridge clip is edited into the V1 track in the Timeline and is 
displayed in the Record monitor. The position indicator rests on 
the Þrst frame of black following the splice.

When you want to 
bring an open bin or 
monitor to the fore-
ground, you can click 
anywhere in it or 
choose its name from 
the Windows menu.

7. Click anywhere in the Record monitor to activate it.

8. Do one of the following to move to the head of the sequence:

¥ Press the Home key.

¥ Click the beginning of the Timeline.

9. Click the Play button to play the shot in the sequence.

10. Choose Clear Monitor from the clip name pop-up menu above the 
Source monitor to close the clip.

Deselect

Yellow
Splice-in
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Splicing a Clip in a Pop-up Monitor

The default setting is to open a clip in the Source or Record monitor. If 
you want, you can change the default to open clips up in a pop-up 
monitor.

1. From the Project window, click the Settings button.

 

2. Double-click the Bin selection (you might have to scroll to locate 
the Bin selection).

The Bin Settings (Current) window opens.

Bin selection

Settings button
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3. Click the ÒOpens new monitor for clipÓ option and click OK.

By default, this loads the clip into a pop-up monitor when you 
double-click the clip.

4. From the bin, double-click the ducks clip.

This opens a pop-up monitor. Previously, you entered IN and 
OUT points, but we need to create different ones. ItÕs not neces-
sary to clear the IN and OUT points. When you create a new IN 
point and OUT point, the system automatically clears previously 
set points.

5. Locate a frame in the pop-up monitor just after the clipÕs midway 
point where the duck that has been sitting in the water is about to 
take off. Using the Step Backward key, mark an IN point Þve 
frames before the duck begins to move its wings to ßy.

6. Mark an OUT point in the Þrst frame after the duck leaves the 
monitor to the left.

Click to open pop-up monitors.
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Playing IN to OUT

Now you can take a look at the marked portion of the clip to make 
sure it is what you want.

1. Click the Play IN to OUT button or press the 6 key on the key-
board.

The Play IN to OUT key plays a clip from the IN point to the OUT 
point.

If possible, it would be nice to provide a little Òbreathing spaceÓ 
before the next shot. 

2. Play the rest of the clip to see if there are several frames of water 
after the duck leaves the shot. 

Using the Go to IN and OUT Buttons

Media Composer provides a number of methods for snapping the 
position indicator to an IN or OUT point.

1. Click the Go to OUT button or press the W key on the keyboard.

The Go to IN (or Q) key places the position indicator at the IN 
point.

Whenever you use the 
numeric keypad, you 
must press Enter after 
typing the number.

2. Type +6 in the numeric keypad and press Enter to add 7 frames to 
the shot.

3. Mark that frame as the OUT point.

The OUT point automatically moves to the new position.

n You can also press the Option key and the Mark IN button to go to the IN 
mark. Press the Option key and the Mark OUT button to go to the OUT 
mark.

Go to Go to
OUTIN
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Moving to the Head and Tail of a Shot

Before splicing in the next shot, make sure the position indicator is on 
the Þrst frame of black after the bridge edit. To do this:

1. Move the position indicator anywhere to the right of the bridge 
clip in the Timeline.

To snap the position 
indicator to the last 
frame of a shot, press 
OptionÐk instead of k 
and click the mouse 
between the ending 
transition and the posi-
tion indicator.

2. While pressing the k (Command) key, click the mouse between 
the transition and the position indicator. The position indicator 
snaps to the Þrst frame of the shot.

3. Select source and record tracks V1 in the Timeline.

Using the Splice-in Button

To splice a shot:

1. With the position indicator at the end of the bridge clip, click the 
yellow Splice-in button under the Source monitor.

The second shot is now edited into the sequence.

2. Go to the head of the sequence and play through the Þrst two 
shots.

Yellow
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Splicing a Shot into the Middle of a Sequence

With nonlinear editing, you can splice a shot anywhere in your 
sequence.

1. To open the clip in the Source monitor, click the Settings button in 
the Project window. 

2. Double-click the Bin selection.

The Bin Settings dialog box appears.

3. Click the ÒLoads clip into source or record monitorÓ option again 
(to deselect it) and click OK.

By default, this loads the clip into the Source monitor when you 
double-click the clip.

4. From the Rough Cut bin, open the kids rowing clip in the Source 
monitor.

5. Mark IN and OUT points to mark 4 seconds of the camera pan-
ning from the girl to the boy.

LetÕs see what this shot looks like between the Þrst and second 
shots.

6. Turn on the V1 and turn off the A1 record tracks.

7. Click in the middle of the ducks clip, between the position indica-
tor and the bridge clip.

8. Press and hold k and click the mouse within the ducks clip in the 
Timeline to place the position indicator on the Þrst frame of the 
ducks clip.

9. Press the Splice-in (V) key on the keyboard.

Wherever you splice a shot into the middle of a sequence, the rest 
of the sequence moves down. Splicing lengthens the material on 
the track.

10. Play the sequence so far to see what you have done.
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Undoing an Edit

The kids rowing shot doesnÕt seem to Þt here. LetÕs undo the last step.

Choose Undo Splice-in from the Edit menu or press k-Z.

Use the Undo feature whenever you feel you have made a mistake or 
want to go back a step. You can undo or redo up to 32 previous actions 
listed in the Edit menu.

Using the I/O (IN Point / OUT Point) Tracking Display

Now you will add two more shots to the sequence. 

1. Open the kids in shadow clip. 

2. Click the Clear Both Marks button.

3. Mark an IN point in the Þrst half of the clip, one frame before the 
second boat enters screen left.

4. Mark an OUT point 3 seconds and 17 frames later (PAL: 3 seconds 
and 14 frames) by following this procedure:

a. Choose I/O from the timecode display pop-up menu (under 
the timecode) in the gray area above the Source monitor.

The I/O option displays the duration from the IN to OUT 
points. If you only mark the IN point, the I/O displays the 
duration from the IN point to the position indicator.

b. Step forward until the I/O display reaches 3:17, and mark the 
OUT point.

5. Turn off the A1 record track.

6. Move the position indicator to the Þrst black frame.

7. Press the V key on the keyboard to splice the clip into the Timeline 
as the third shot. 
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8. Open the rowing forward clip and mark an IN point a little less 
than halfway through the clip, when the dory is evenly centered 
between the right and left edges of the frame.

9. Mark an OUT point 5 seconds later.

10. Save the bin.

11. Splice the clip into the Timeline as the fourth shot.

12. Choose Save All Bins from the File menu.

YouÕve Þnished this tutorial. You can go on to Tutorial: ReÞning Edits 
on page 123, or exit Media Composer.
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CHAPTER 7

ReÞning the Edit

ReÞning edits tightens and improves the relationship between pic-
tures and sound. This is described in the following sections:

¥ Using Segment Mode

¥ Basic Trim Procedures

¥ Using the Command Palette

¥ Audio Editing

Tutorial: ReÞning Edits contains the following sections:

¥ Overwriting Shots into a Sequence

¥ Marking Clips for Storyboarding

¥ Rearranging Shots

¥ Removing Footage from a Sequence

¥ Trimming

¥ Working with Audio
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Using Segment Mode

Segment mode provides editing controls for moving, deleting, mark-
ing, and editing entire segments in the Timeline. A segment is a portion 
of the sequence that includes two or more transitions. There are two 
modes for editing segments or adding shots: Extract/Splice-in, indi-
cated by a yellow arrow, and Lift/Overwrite, indicated by a red arrow.

Unlike traditional tape editing, Segment mode allows you to instantly 
reposition entire segments using visual controls as though you were 
physically ÒdraggingÓ portions of your sequence around on a tape. 
You can move shots separately or together, on one track or across 
tracks.

Editing in Segment Mode

Observe the following guidelines when editing in Segment mode:

¥ Transition effects on either side of a moved selection are deleted. 
Transition effects inside the selection are preserved.

¥ You can track the audio while moving segments by pressing the 
Caps Lock key to enable audio scrub.

¥ When you are Þnished, Segment mode continues to affect your 
editing in Source/Record mode or Trim mode unless you click the 
active Segment Mode button to deactivate it.

Distinguishing Two Types of Buttons

In Chapter 6, you used the Splice-in button. The Splice-in button and 
the Overwrite button (see ÒOverwriting Shots into a SequenceÓ on 
page 124) take clips from the Source pop-up monitor and put them 
into the Timeline. The Segment mode buttons, Extract/Splice-in and 
Lift/Overwrite, move segments around within the Timeline. The 
names are similar but you use them for different purposes.
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Basic Trim Procedures

For illustrations of the 
various types of trim 
edits you can perform 
in Trim mode, see the 
Avid Media Composer 
and Film Composer 
Quick Reference.

You can enter Trim mode in several different ways, depending on the 
type of trim you expect to perform. Once in Trim mode you can:

¥ Select additional tracks 

¥ Toggle between Big and Small Trim mode

¥ Toggle between trim sides

¥ Perform and play back the trim

Entering Trim Mode

There are four alternative methods for entering Trim mode:

¥ Clicking the Trim Mode button. By default the system enters 
Trim mode and selects the tracks nearest the position indicator for 
dual-roller trimming. This method is useful for selecting straight-
cut transitions on one track or across video and audio tracks.

When you deselect one or more tracks in the Track Selector panel, 
by default only the transitions in the highlighted tracks are 
selected for trimming. If the transitions are not straight cuts (over-
lap cuts or L-edits), the system highlights the topmost track near-
est the position indicator.

¥ Lassoing the transitions in the Timeline. This method is useful 
when you need to select multiple transitions staggered across par-
allel tracks (overlap cuts) for simultaneous trimming.

Transition selected
for trimming
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You can drag from right to left, or left to right, and you can lasso 
single transitions across several contiguous tracks. However, 
avoid lassoing more than one transition on a single track, because 
this activates Segment mode.

n To select transitions located below several track layers, draw a lasso within 
the Timeline by pressing the Control key while you drag.

¥ Using the Go to Previous/Next Edit. By default the system selects 
the nearest transition in either direction of the selected track for 
dual-roller trimming. 

If the transition is a straight cut, the system selects all edited 
tracks. If the transition is an overlap edit with staggered transition 
points, the system selects the topmost track.

¥ Using the Play Loop button. This is useful if you like to trim 
quickly as you edit, going back and forth between Trim mode and 
other edit modes. 

n The Play Loop button does not appear in Source/Record mode by default. You 
must map it to the keyboard or a palette in advance. For information on but-
ton mapping, see  ÒUser-selectable buttons, mappingÓ in the online help 
index.

Lasso drawn across three tracks

Transitions are selected for dual-roller trim
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Exiting Trim Mode

You can exit Trim mode at any time in one of several ways:

¥ Click the Source/Record Mode button or the Effect Mode button.

¥ Press the Escape key on the keyboard to enter Source/Record 
mode by default.

¥ Click a speciÞc location in the Timecode (TC1) track at the bottom 
of the Timeline to exit Trim mode.   The position indicator moves 
to that location.

Toggling Between Big and Small Trim Mode

When you click the Trim Mode button, by default the system enters 
Big Trim mode. If you click the Trim Mode button again, the interface 
toggles between Big and Small Trim mode. This feature has the fol-
lowing uses:

¥ If you prefer the display of Small Trim mode, but need quick 
access to the Playback Duration controls from time to time, you 
can perform most of your work in Small Trim mode. Whenever 
you need the controls, click the Trim Mode button. This saves you 
the extra step of opening the Trim Settings dialog box each time.

esc

Click in the TC track at a 
selected location

The system exits to Source/Record 
mode, and relocates the position 
indicator
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¥ If you prefer the larger monitors and controls of Big Trim mode, 
select this as the default. When you need to use the Monitor 
menus to switch between sequences, or have occasion to edit 
source material into the sequence, you can click the Trim Mode 
button to enable Small Trim mode, which includes the Source 
monitor controls.

Selecting Between Trim Sides

There are three ways to select sides of a transition to trim:

¥ In Big or Small Trim mode display, click the outgoing (A-side) or 
incoming (B-side) monitor to deÞne which side of the transition to 
trim. Notice that the pointer changes to a single-roller A-side, sin-
gle-roller B-side, or double-roller icon depending on position.

¥ You can also use the Trim-side keys on the default keyboard (or 
map them onto one of the monitor palettes while in Trim mode) to 
select side A, side B, or both.

¥ You can use the Cycle Trim Sides button to cycle between selection 
of the A-side, B-side, or both.

The selected parts of the transition are highlighted, and the corre-
sponding rollers appear in the Timeline. Also, one or both of the 
frame counter indicators below the monitors are highlighted to 
reßect the active trim sides: A-side, B-side, or both. The number 
indicates how many frames have been added or subtracted (-) 
from the transition.

A-side B-side A and B

A-side
A and B

B-side

Highlight indicates

A-side B-side

Active sides
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Performing a Basic Trim

With your transitions and trim sides selected, you can perform a basic 
trim using one of the following alternative procedures:

¥ Use the Trim buttons to trim forward or backward by one- or ten-
frame increments.

¥ Use the numeric keypad at the right side of the keyboard, as 
follows:

- To move the transition a speciÞc number of frames, type a 
plus sign (+) or minus sign (Ð) and the number of frames (from 
1 to 99) you want to move forward or backward. Then press 
Enter. If the number of frames is larger than 99, type an F after 
the number to indicate frame count. For example, to enter 200 
frames, type 200F and press Enter.

- To move the transition to an exact timecode, type a timecode 
number larger than 99, including frames. For example, type 
102 to enter 1 second and 2 frames. 

¥ Use controls in the Timeline by clicking a roller at the selected 
transition and dragging forward or backward in the sequence.

¥ For greater control:

- Press the Option key as you drag to move one frame at a time.

- Press the Command key to snap to other transition points.

As you trim, all selected transitions in the Timeline move in unison. 
The Frame counter displays the frame count backward or forward for 

10 Frames 1 Frame

Click and drag a transition in the Timeline
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one or both trim sides, and the monitors display the new incoming or 
outgoing frames.

Using the Command Palette

The Command Palette provides a central location for all user-selectable 
buttons (USBs) that you can map to various locations for ease of use. 
User-selectable buttons allow you to perform a wide range of com-
mands with a single click. You can map buttons to any command pal-
ette in a pop-up, Source, or Record monitor and to reconÞgure the 
keyboard, AvidDroid buttons, or the Manual User Interface (MUI) 
keys. You can also map menu commands to various buttons and keys.

You can use the buttons directly from the Command Palette without 
mapping them by deselecting the two boxes at the bottom of the Com-
mand Palette, ÔButton to ButtonÕ Reassignment and ÔMenu to ButtonÕ 
Reassignment.

The Command Palette groups buttons by editing function. Tabs are 
displayed for each function and the buttons that perform those func-
tions are displayed within each tab. The functions are: Move, Play, 
Edit, Trim, FX, 3D, MCam, and Other. 

All buttons are displayed in the Command Palette. If you cannot Þnd a 
particular button, open the Command Palette from the Tools menu 
and search for it there. For procedures on mapping user-selectable but-
tons and menu commands, see ÒUser-selectable buttons, mappingÓ in 
the online help index.
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Figure 7-1 Master Command Palette Tabs

Move buttons

Play buttons

Edit buttons

Trim buttons
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Figure 7-2 Master Command Palette Tabs (Continued)

Effect buttons

3D buttons

MCam buttons

Other buttons

Workspace buttons
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Audio Editing

The Media  Composer system provides audio scrub features and 
waveform plots speciÞcally designed for frame-accurate cueing, mark-
ing, and editing of audio. You can use these features any time during 
editing or while making adjustments with the audio tools.

Adjusting Volume

You can use the Audio Mix Tool to adjust volume (level) and balance 
(pan).

Pan adjustment Level adjustment
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Tutorial: Refining Edits

In this tutorial you reÞne and trim edits and adjust audio levels. This 
section corresponds to the clips and sequence in the bin titled ReÞning 
Edits.

n Be sure to read the preceding overview sections of this chapter before you start 
this tutorial.

Table 7-1 Starting the Tutorial: Refining Edits

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the ReÞning 
Edits bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the sequence you were 
working on from the previous 
tutorial into the ReÞning 
Edits bin. Close the Rough 
Cut bin.

2. From the Boat Shop Project 
window double-click the Rough 
Cut bin and the ReÞning Edits 
bin to open them.

2. Click and drag the ReÞning 
Edits Sequence clip into the 
Composer monitor to begin the 
tutorial.

3. Drag the sequence you 
were working on from the 
ReÞning Edits bin into the 
Composer monitor.

3. Press the Option key and drag 
the sequence you were working 
on from the previous tutorial 
into the ReÞning Edits bin. 
Close the Rough Cut bin.

4. Drag the sequence you were 
working on from the ReÞning 
Edits bin into the Composer 
monitor.
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Overwriting Shots into a Sequence

In addition to splicing, you can overwrite shots into a sequence. An 
overwrite edit replaces a section of a sequence with other source foot-
age. An overwrite edit does not affect the length of the sequence.

The rowing forward shot is too long. In this section you will edit the 
next shot into the sequence before the end of the rowing forward clip.

1. Make sure the Record monitor is active.

2. Place the position indicator in the Timeline on the Þrst frame of 
rowing forward.

3. Advance 3 seconds by entering +229 (+224 PAL) in the numeric 
keypad, then pressing Enter.

4. Mark an IN point.

 

5. Open the dories passing clip. 

6. Mark an IN point in the Þrst half of the clip, 18 frames (15 frames 
PAL) after the tips of the two boats seem to touch in the middle of 
the screen. 

7. Mark an OUT point a few frames less than 7 seconds later, when 
the girlÕs oars are both out of the water, and her left oar just catches 
the light.

8. Click the Overwrite button or press the B key on the keyboard.

The shot overwrites the end of the rowing forward clip and 
extends beyond it, thus lengthening the video portion of the 
sequence.

Mark In point

Red on the
monitor
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You should now be at about 19:20 into the sequence, with Þve video 
clips in it.

Marking Clips for Storyboarding

Storyboarding allows you set up a group of clips in a sequence of 
events and then load them into the Record monitor all at once.

In this section, you will mark a group of clips using instructions in 
Table 7-2. The table provides a timecode to set the IN point and based 
on the duration, you can use the numeric keypad to Þgure out the 
OUT point. 

Use the following procedure to set your IN and OUT points for each 
clip in the table:

1. Load a clip listed in Table 7-2 in its Source monitor.

2. Choose V1 in the timecode display pop-up menu above the Source 
monitor.

You will use the V1 numbers to go to the IN point.

3. Mark your IN point based on the Mark IN timecode in Table 7-1.

You might have set the IN and OUT points for these clips in the 
previous lesson. Check them to see whether or not they need to be 
reset.
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4. To set the OUT point, enter the duration (from Table 7-2) in the 
numeric keypad and press Enter.

5. Mark the OUT point.

6. Continue marking IN and OUT points for the remaining clips, but 
do not edit the clips into the sequence yet.

Table 7-2 Mark Points for Boat Shop Clips 

Clip name Mark IN point Duration

draw knife cu 05:02:08:09 1:16 (NTSC)

1:13 (PAL)

chiseling 04:11:34:22 00:16 (NTSC)

00:13 (PAL)

hammering 04:05:10:08 1:00

drilling 04:04:47:25 1:00

planing cu 04:10:05:17 2:00

planing ms 04:09:24:00 3:19 (NTSC)

3:16 (PAL)

sanding 04:06:52:03 3:12 (NTSC)

3:10 (PAL)

wood burning 04:14:24:02 6:15 (NTSC)

6:12 (PAL)

two dories 01:11:03:03 1:22 (NTSC)

1:18 (PAL)

rowing in mist 01:02:38:29 1:22 (NTSC)

1:18 (PAL)
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Storyboard Editing the Clips

1. Display the ReÞning Edits bin in Frame mode and click the zoom 
box so the bin Þlls the screen, or click and drag the lower right cor-
ner of the bin to enlarge the window.

2. Choose Fill Window from the Bin menu to arrange the clips in the 
bin.

3. Drag the draw knife cu clip to a clear space in the lower left area 
of the bin.

4. Arrange the following clips (after draw knife cu) in two or three 
rows, from left to right, and top to bottom, to form the storyboard. 
Make sure you maintain the order of clips:

¥ chiseling

¥ hammering

¥ drilling

¥ planing cu

¥ planing ms

¥ sanding

¥ wood burning

¥ two dories

dories ws 01:06:38:26 4:00 

dories to models 04:25:22:28 3:23 (NTSC)

3:19 (PAL)

sign 05:06:52:01 10:00 (NTSC)

10:00 (PAL)

Table 7-2 Mark Points for Boat Shop Clips (Continued)

Clip name Mark IN point Duration

Frame mode
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¥ rowing in mist

¥ dories ws

¥ dories to models

¥ sign

Now youÕre ready to load the marked clips into the sequence.

5. Place the position indicator in the Timeline on the Þrst frame of 
black following the dories passing clip and press k while clicking 
the mouse.

6. Select only record track V1 and deselect A1 in the Timeline.

7. Select the storyboarded clips all at once:

a. Position the mouse pointer in the bin in the blank area just to 
the left of the draw knife cu clip. 

b. Lasso the clips by dragging the pointer to the right and down, 
making sure to select all of the storyboarded clips.

A box forms as you move the mouse, starting next to the draw 
knife cu clip and ending at the last pointer position. All the 
names are highlighted in pink.

8. Hold the Option key, press the mouse on one of the clips (on the 
image, not the name), and drag the group into the Record monitor. 
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Release the mouse when a yellow arrow appears in the Record 
monitor. 

The shots are edited in the sequence in the order you speciÞed. 

9. To play the sequence: 

a. Move the position indicator to the head of the sequence. 

b. Activate the speaker icons for tracks A1 and A2 by clicking the 
record track monitors (only one record track monitor can be 
activated at a time).

Track A2 contains sound for several clips.

c. Click the Play button under the Record monitor.

Rearranging Shots

You can rearrange shots by overwriting material, lifting material, or 
removing material. Overwriting material doesnÕt change the length of 
the sequence. Lifting material  leaves Þller and doesnÕt affect the 
length of the sequence. Removing material shortens the length of the 
sequence.

Overwriting with the Three-Point Edit

The three-point edit is an excellent way to replace a shot in a sequence. 
Use the Mark Clip button to select the shot in the sequence (or mark an 
IN and OUT point for a segment thatÕs not a single shot), and mark 
either the IN or OUT point in the source clip. The system calculates the 
exact duration of the source clip to insert.

LetÕs replace the chiseling shot with draw knife ms to create a 
smoother movement across the cut.

Record

 monitor
track
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1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale bar and drag the scale box to enlarge the Time-
line.

The Timeline wraps onto another line, displaying multiple 
Timelines.

c. Click and drag the scale box to the right until you see the 
entire chiseling clip.

The Timeline splits in half (or thirds) as it wraps through the 
sequence.

2. Move the position indicator to the chiseling clip.

3. Select only record tracks V1 and A2.

4. Click the Mark Clip button in the row of buttons below the Record 
monitor, or press T on the keyboard.

The IN and OUT points appear at the head and tail of the clip in 
the TC1 track of the Timeline; the marked segment turns purple. 

The IN and OUT points also appear in the Record monitorÕs posi-
tion bar.

5. Open the draw knife ms clip in the Source monitor and mark an 
IN point around 2.5 seconds into the clip, when the boatbuilderÕs 
motions become smooth.

6. Clear any OUT marks.

7. Click the red Overwrite button or press the B key on the keyboard 
to make the three-point edit.

The shot draw knife ms replaces the chiseling shot.

8. Return to the previous Timeline view by doing the following:

a. Click and drag the scale box to the left.
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b. Move the position indicator in the Record monitor to the head 
of the sequence.

Rearranging Footage with Extract/Splice-in

Extract/Splice-in is a great tool for changing the order of shots in a 
sequence. LetÕs see what it looks like if we reverse the position of two 
shots in the sequence, rowing in mist and two dories.

1. Expand the Timeline again with the scale box; drag and click the 
scale box toward the end of the sequence until you reach the row-
ing in mist clip.

2. Click the yellow Segment Mode (Extract/Splice-in) button below 
the Timeline.

When the button is activated, its background turns light gray.

c DonÕt confuse the Extract/Splice-in and Splice-in buttons. The 
Extract/Splice-in button is located below the Timeline; the Splice-in 
button is located on the keyboard and between the Record monitor 
and the Source monitor (see ÒDistinguishing Two Types of ButtonsÓ 
on page 113).

3. Select only track V1. Deselect all audio tracks.

4. Press and hold k key and click and drag the rowing in mist shot 
to the left, so it is completely over the two dories shot, and release 
the mouse. 

Two dories should now follow rowing in mist.

5. Click the Extract/Splice-in button again to deactivate it.

6. Click the Timeline in front of the two shots and play the shots. 

The edit works.
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Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain 
the gap that results. Extract/Splice-in closes the gap, and Lift retains 
the gap.

Removing Footage with Extract/Splice-in

The planing ms shot breaks up the feeling of being close to the action. 
LetÕs remove it from the sequence and close the gap that results.

1. Use the scroll bar to locate the planing ms clip.

2. Click the yellow Segment Mode (Extract/Splice-in) button below 
the Timeline.

To eliminate footage 
that does not start and 
end at a transition, use 
IN and OUT points to 
delimit the segment 
that you want to 
extract. 

3. Click anywhere in the planing ms clip on V1, then Shift-click the 
audio portion of the clip in track A2.

The clip is highlighted in both tracks.

4. Press the Delete key on the keyboard.

The selected shot is eliminated and the surrounding shots close 
the gap.

5. Click the Extract/Splice-in button again to deselect it.

Removing Footage with Lift

Lift retains the gap after lifting footage from the sequence.  Use Lift if 
you want to maintain the rhythm of a sequence or the synchronization 
of the video and audio tracks.

The dories passing shot plays for too long, but we want the next shot, 
draw knife cu, to remain in sync with the audio. We will use Lift to 
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shorten dories passing, but maintain the same entrance point for the 
next shot. Later, weÕll Þgure out something to put in its place.

1. Display the master timecode in the Record monitorÕs timecode 
display by choosing Mas from the timecode pop-up menu.

2. Turn off track A2.

3. Mark an IN point in the sequence at master timecode 01:00:17:29 
(01:00:17:24 PAL) by using the Mark IN button below the Record 
monitor. 

4. Go to the last frame of the dories passing segment by placing the 
position indicator in the next clip beyond dories passing. Press 
and hold k-Option and click the mouse.

5. Mark an OUT point.

You must mark an IN and OUT point in the sequence.

6. Click the Lift button or press the Lift key (Z) on the keyboard to 
remove the segment.

The selected segment lifts out and leaves black Þller in its place.

7. Play the entire sequence in the Record monitor.

Trimming

Trimming allows you to adjust incoming and outgoing frames of your 
clip. There are two types of trims: dual-roller and single-roller.

Dual-Roller Trimming

Use a dual-roller trim to adjust both sides of a transition simulta-
neously, adding frames to one shot while subtracting frames from the 
adjacent shot. The total duration of the sequence does not change.

LetÕs cut the kids in shadow shot right on the beat of the music. 
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1. Select record track V1 and deselect the audio tracks. Make sure the 
A1 speaker is turned on in the Timeline.

2. Place the position indicator near the ducks/kids in shadow tran-
sition, and click the Trim Mode button below the Timeline.

The position indicator snaps to the transition.

The Record monitor shows the last (tail) frame of the ducks shot 
and the Source monitor shows the Þrst (head) frame of the kids in 
shadow shot on the right.

New buttons appear below the trim windows. Note that during 
double-roller trim mode, both frame counters are purple.

 

Trim
transition

Transition effect
palette

Outgoing video Incoming video

Frame
countersTrim frame buttons

buttonPlay Loop
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n To see the second row of buttons, click Settings in the Boat Shop Project win-
dow, then choose Composer. In the Composer Settings dialog box, click Sec-
ond Row of Buttons, then click OK.

3. Play the transition by clicking the Play Loop button.

If this button does not appear, choose Command Palette from the 
Tools menu, click the Play tab, deselect the boxes at the bottom of 
the tab, then click the Play Loop button.

The transition plays repeatedly.

4. To stop the playback loop, click the Play Loop button again.

5. Press the Caps Lock key on the keyboard so you can hear the 
audio as you trim. 

To use digital audio scrub, make sure the speaker icon for record 
track A1 is hollow and increase the speaker volume, if necessary. 

6. Press the Option key and click the speaker icon for track A1 if it is 
not hollow.

7. Click the Trim Right One Frame button under the Source monitor 
until you hear a change in loudness around the seventh frame 
(sixth frame PAL).

This adds frames to the tail of the outgoing shot and removes 
them from the head of the incoming one. The duration of the video 
track remains unchanged.

8. Play the transition again by using the Play Loop button.

 

Hollow speaker icon

Trim Right
One Frame

Trim Left
One Frame

Trim Left

Ten Frames

Trim Right

Ten Frames
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9. Do one of the following to exit Trim mode:

¥ Click the Source/Record Mode button below the Timeline.

¥ Press the Left Arrow key on the keyboard.

Using Dual Rollers to Trim the Outgoing Shot

LetÕs insert a shot to take the place of the Þller we left in the sequence. 
YouÕll replace the Þller with pan lumber, because this shot will pro-
vide continuity of movement from the previous shot. Once you over-
write the shot into the sequence, youÕll trim it.

1. Place the position indicator within the Þller between the dories 
passing and the draw knife cu clips.

2. Select record tracks V1 in the Timeline, and deselect A1 and A2.

3. Click the Mark Clip button under the Record monitor or press T 
on the keyboard.

4. Open the pan lumber clip and mark an OUT point where the lum-
ber is in sunlight and the camera stops panning. Do not mark an 
IN point.

5. Select record tracks V1 and A2.

6. Click the red Overwrite button between the Source/Record 
window.

c DonÕt confuse the Lift/Overwrite and Overwrite buttons. The Lift/
Overwrite button is located below the Timeline; the Overwrite but-
ton is located on the keyboard and between the Source/Record 
window.
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Trim Shot

In the next steps, you will trim the pan lumber shot so it enters a little 
earlier.

1. Enter Trim mode by lassoing the Timeline tracks: 

a. Click the cursor above all the Timeline tracks just to the left of 
the dories passing/pan lumber transition. 

b. Drag the mouse down and to the right to surround the
transition.

The trim rollers appear.

2. Move the transition 74 frames earlier by clicking the Trim
Left Ten Frames button 7 times and the Trim Left One Frame but-
ton 4 times.

You see the numbers change in the purple frame counters.

Single-Roller Trimming

In the trims you made so far, you trimmed both the head and the tail 
shots an equal number of frames, adding to one side and subtracting 
from the other. Now letÕs trim the tail of the pan lumber shot without 
affecting the head of the draw knife cu shot.

1. While still in Trim mode, advance to the pan lumber / draw knife 
cu transition by pressing S on the keyboard.

2. Select track A2 in addition to V1 in the Timeline because you will 
trim both the audio and video of the shot.

Trim mode
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3. Click the left frame counter (A-Side Trim counter).

Your trim will only affect the outgoing shot, which is in the left 
Trim monitor. The left frame counter remains purple, while the 
right one is deselected.

4. Type -10 and press Enter on the numeric keypad to subtract 10 
frames from the outgoing shot.

This moves the transition 10 frames to the left.

5. Leave Trim mode by pressing the Left Arrow key on the keyboard 
or by clicking the Source/Record mode button below the
Timeline.

Adding Synced Audio

Now weÕll add some synced audio to the sequence.

1. Open the intervu: LowellÕs Boat Shop clip.

Be sure the volume on the speakers is turned up.

2. Mark the IN point at the start of the Þrst phrase, ÒLowellÕs Boat 
Shop isnÕt quite the same as it always has been...Ó and mark the 
OUT point at the end of the last phrase, Ò...a great symbol of New 
England.Ó

3. Press the Play IN to OUT (6) button on the keyboard to play the 
clip from the IN to OUT marks. 

The audio is on track A1 in the source clip, but we want to add it to 
the end of track A2 in the Timeline. 

First weÕll patch from source track A1 to record track A2.

4. To patch the track, quickly drag the cursor from the A1 source 
track icon to the A2 record track icon.

Left frame
counter
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5. Display the master timecode (Mas) in the timecode display above 
the Record monitor.

6. In the sequence, place the Mark IN point at master timecode 
01:00:41:00 (01:00:40:25 PAL), in the middle of the dories ws clip. 

7. Make sure source track A1 and record tracks V1 and A2 are 
selected. 

8. Click the Splice-in button between the Source/Record window.

The audio is patched into the sequence.

Working with Audio

In this section, youÕll adjust audio levels to the already placed intervu: 
LowellÕs Boat Shop clip.

Adjusting Audio Level

The volume in the intervu: LowellÕs Boat Shop shot is noticeably 
lower than in the rest of the sequence. LetÕs make this shot louder.

1. Select record track A2 and deselect track A1.

2. Place the position indicator anywhere within the intervu: LowellÕs 
Boat Shop shot.

3. Choose Audio Mix from the Tools menu.

4. In the A2 area, move the A2 Audio Level slider to level +6 by 
doing one of the following:
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¥ Drag the slider to level +6.

¥ Type 6.

¥ Press the Up or Down Arrow key on the keyboard to reach 
level +6.

5. Play a portion of the shot.

The volume is still too low.

6. Activate the Audio Mix Tool by clicking in it, and move the slider 
to level +10.

Adjusting Audio Pan

Most of the audio for the sequence plays only out of the left speaker; 
the intervu: LowellÕs Boat Shop shot plays only out of the right 
speaker. You can adjust the audio pan (balance) so the sound plays 
equally from both speakers.

1. Clear any IN or OUT points from the sequence by pressing the G 
key on the keyboard.

2. Select record tracks A1 and A2.

3. Activate the Audio Mix window by clicking anywhere in it.

Level slider

 Type a number
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4. Click the TimelineÕs position indicator at a point that has audio on 
track A1.

5. From the Audio Mix window, pull down None and choose A1 
from the Þrst Pan Adjustment window.

6. Pull down the Pan Adjustment window for track A1.

The Pan slider appears.

7. Drag the Pan slider to the middle of the scale until it reads MID.

To make the slider snap 
to MID, press the 
Option key and click 
the Pan slider.

8. Pull down the Pan Adjustment window for track A2 and drag the 
Pan slider until it reads MID.

9. Play a portion of the sequence to check speaker balance.

10. Click the close box to close the Audio Mix window.

YouÕve Þnished this tutorial. You can go on to Tutorial: Adding Effects 
on page 123, or exit Media Composer.

Drag Pan slider.

Click here
to open the

Pan Adjustment
window.

Choose A1.
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CHAPTER 8

Adding Effects

Adding an effect to a clip enhances your sequence by fading in or out 
of a scene or adding video or a graphic on top of a clip. This is 
described in the following sections:

¥ Effects Editing

¥ Displaying the Effect Palette

¥ Effect Types

¥ Applying Effects to a Sequence

¥ Transition Effects

¥ Working in Effect Mode

¥ Rendering an Effect

Tutorial: Adding Effects contains the following sections:

¥ Adding Transition Effects

¥ Adding a Picture-in-Picture Effect

¥ Screening the Sequence
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Effects Editing

The Avid Composer system offers many effects that you can apply to 
your sequences. You can also use third-party plug-in effects that are 
compatible with Adobe Photoshopª. The effects that are available on 
your Avid Composer system depend on the model and options that 
you purchased. For the list of effects available for your model, see the 
online book Avid Media Composer Products Reference.

This chapter explains how to apply effects to transitions or segments 
(clips) in your sequence. After you have selected the effect and applied 
it to a transition or segment, you can adjust the effect parameters to 
meet your requirements.

Many effects are real time, which means you do not have to render 
them before you play them. You can preview effects that are not real 
time before rendering. Rendering an effect creates a media Þle that 
plays with the sequence.

After you create an effect, you can save it as an effect template and 
reapply the template to other transitions or segments in your 
sequence. Some effects can be applied only to transitions, other effects 
can be applied only to segments, and some effects can be applied to 
both transitions and segments. In addition, some effects can be applied 
to a single video layer, and others to multiple video layers.

For an explanation of particular effects and the effect parameters, see 
Ó2D Effects ReferenceÓ and Ò3D Effects EditingÓ in the Avid Media 
Composer and Film Composer Effects Guide.
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Displaying the Effect Palette

You select most effects from the Effect Palette in the Tools menu. The 
exceptions are Motion effects that you access from the Fast menu 
above the Source monitor, the Freeze Frame effect that you access from 
the Clip menu, and titles that you create with the Title Tool.

Effect Categories

The effects available through the Effect Palette are grouped by effect 
category:

¥ Blend

¥ Box Wipe

¥ Conceal

¥ Edge Wipe

¥ Film

¥ Image

¥ Key

¥ L-Conceal

¥ Matrix Wipe

¥ Peel
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¥ Push

¥ Saw Tooth Wipe

¥ Shape Wipe

¥ Spin

¥ Squeeze

Each of these effect categories contains multiple effects.

Effect Types

There are two primary effect types that are deÞned by where you use 
them in a sequence:

¥ Transition effects

¥ Segment effects (single-layer and multilayer)

Transition Effects

A transition is the point where two clips meet. You apply a transition 
effect to the cut point between two clips on the same video track. After 
you apply a transition effect, you can adjust its relative position and 
duration. Depending on the speciÞc effect, other effect parameters 
may apply.

Transition effects are included in all effect categories on the Effect 
Palette, except the Image effect category.

For an explanation of the transition effects in each effect category, see 
the Avid Media Composer and Film Composer Effects Guide.
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Segment Effects

You apply a segment effect to an entire clip or a group of clips. There 
are two types of segment effects:

¥ A single-layer segment effect, such as a Mask, is applied to a seg-
ment on one video track.

¥ A multilayer segment effect, such as a Picture-In-Picture effect, is 
applied to the top layer of segments that contain two or more 
video tracks that will be played simultaneously.

All of the Avid effects and their effect types are listed in the Avid Media 
Composer and Film Composer Effects Guide.

Applying Effects to a Sequence

This section explains how to apply an effect to a sequence in the 
Record monitor. You can apply an effect:

¥ To one transition or segment on a single video layer

¥ To multiple transitions or segments on a single video layer

¥ To multiple transitions or segments on multiple video layers

The effect type (transition or segment) determines where you can 
place the effect in the sequence. For an explanation of the effect types, 
see ÒEffects:types ofÓ in the online help index.

After you apply an effect, the next step is to adjust the effectÕs parame-
ters. To understand how to adjust the effect parameters, see ÒEffect 
Mode:adjusting parameters inÓ in the online help index.
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Working in Effect Mode

After you have created an effect and applied it to a transition or seg-
ment in your sequence, you can adjust its appearance and operation 
by changing its effect parameters in Effect mode. 

Not all effect parameters apply to all effects. Parameters that do not 
apply to an effect are disabled in the Effect Mode window. To deter-
mine which parameters pertain to an effect, refer to the effectÕs 
description in the Avid Media Composer and Film Composer Effects Guide.

Rendering an Effect

You must render a non-real-time effect before it can be played. When 
an effect is rendered, the system stores the effect and its media Þle as a 
precomputed master clip (often referred to as a precompute). The sys-
tem uses the precompute to play the effect at its normal speed.
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Tutorial: Adding Effects

In this tutorial you add dissolves and a picture-in-picture effect. This 
section corresponds to the clips and sequence in the bin titled Adding 
Effects.

n Be sure to read the preceding overview sections of this chapter before you start 
this tutorial.

Table 8-1 Starting the Tutorial: Adding Effects

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the Adding 
Effects bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the sequence you were 
working on from the previous 
tutorial into the Adding 
Effects bin. Close the ReÞn-
ing Edits bin.

2. From the Boat Shop Project 
window double-click the ReÞn-
ing Edits bin and the Adding 
Effects bin to open them.

2. Click and drag the Adding 
Effects Sequence into the 
Composer monitor to begin the 
tutorial.

3. Drag the sequence you 
were working on from the 
Adding Effects bin into the 
Composer monitor.

3. Press the Option key and drag 
the sequence you were working 
on from the previous tutorial 
into the Adding Effects bin. 
Close the ReÞning Edits bin.

4. Drag the sequence you were 
working on from the Adding 
Effects bin into the Composer 
monitor.
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Adding Transition Effects

Transition effects are added in between two clips. Effects you can use 
include: Blend, Box Wipe, Conceal, Edge Wipe, Film, Image, Key, L-
Conceal, Matrix Wipe, Peel, Push, Saw Tooth Wipe, Shape Wipe, Spin, 
and Squeeze.

Displaying Editing Buttons

Before you add effects to the tutorial sequence, you need access to 
some effects editing buttons.

1. Choose Composer Settings from the Special menu.

The Composer Settings window opens.

2. Make sure the Second Row of Buttons is selected.

Second row of
buttons option
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3. Click OK.

A second row of buttons appears under the Source/Record 
window. 

Adding Fade In

Now weÕll add a fade in effect to a transition.

1. If you donÕt see any video in the Record monitor, click the box to 
the right of V1 so a square (tiny monitor) appears. 

The video appears in the Record monitor.

2. Select the V1 record track and click the head of the sequence.

3. Press and hold the Fast Menu button between the Source/Record 
monitors.

4. Click the ADD DISS (Add Dissolve) button.

A dialog box appears.

Fast Menu button
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5. Create a 20-frame dissolve (fade in), starting at the cut by doing 
the following:

a. Choose Dissolve from the Add pop-up menu.

b. Type 20 in the Duration text box.

c. Choose Starting at Cut from the Position pop-up menu.

6. Choose the disk on which the effect media Þle should be stored 
from the Target Disk pop-up menu.

The default disk is Effect Source Disk.

n Make sure the DonÕt Render Real-Time Effects box is not selected.

7. Click the Add and Render button to render the effect.

The system creates the media Þle of the video effect during the 
rendering process. It also places a box in the Timeline where you 
added the effect.

8. Play the effect. Press the space bar to stop playback.

Dissolving Between Shots

You can create a nice effect by adding a dissolve between the Þrst two 
shots of the sequence.

1. Select the V1 record track and click the Þrst frame of the ducks 
clip.

2. Click the Add Dissolve button in the Fast menu. 

3. Create a 20-frame dissolve, centered on the cut.

a. Choose Dissolve from the Add pop-up menu.

b. Type 20 in the Duration text box.

c. Choose Centered on Cut from the Position pop-up menu.

4. Choose the disk on which the effect media Þle should be stored.

5. Click the Add and Render button.
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6. Play the effect. Press the space bar to stop playback.

Creating a Series of Dissolves

After you create one dissolve, you can quickly add it to other transi-
tions in a sequence. In this section, youÕll add a series of dissolves in 
the middle of the sequence to smooth the transition between several 
short shots.

1. Place the position indicator at the transition between dories pass-
ing and pan lumber.

2. Create a 10-frame dissolve, centered on the cut.

3. Repeat steps 1 and 2 for all transitions through sanding/wood 
burning.

If you canÕt see the clips in the Timeline, use the scale bar to 
expand the Timeline.

n You do not have to change any dissolve parameters when you make these dis-
solves.

4. Play the sequence through to see your work.

Creating Audio Dissolves

ItÕs just as easy to add audio dissolves, and the procedure is the same 
as adding video dissolves.

As an exercise, create audio dissolves for every audio transition on 
track A2 through sanding/wood burning except the beginning and 
the end.

Use 10-frame dissolves, centered on the cut. Be sure to select track A2 
and deselect other tracks.
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Adding a Fade Within the Sequence

Now weÕll create a fade to black within the sequence after the dories 
passing shot, to cut more forcefully on the words, Òwooden boat 
building.Ó Notice that the transition already has a 10-frame dissolve.

1. Place the position indicator on the last frame of the dories passing 
shot.

2. Select only track V1.

3. Click the REMO EFFE (Remove Effect) button in the Fast menu.

The dissolve is removed from the transition.

4. Without moving the position indicator, mark both an IN and an 
OUT point on that frame.

DonÕt use the Mark Clip button.

5. Click the red Segment Mode (Lift/Overwrite) button below the 
Timeline.

6. Press k-X.

A single frame is lifted from the sequence, leaving one frame of 
black.

7. Deselect the Lift/Overwrite button.

8. Add a 20-frame dissolve, ending at the cut.

9. Select the disk drive and click the Add and Render button to add 
and render the dissolve.

Adding a Picture-in-Picture Effect

WeÕll make one Þnal change to increase the impact of the last part of 
the sequence. Using a Picture-in-Picture effect, youÕll squeeze the 
image of the boat shop owner into the lower left corner of the screen, 
and lay some other images behind him.
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Using the Second Video Track 

This effect will take up two video tracks: V1 for the shots of boats and 
boating and V2 for the interview. First, you have to move the inter-
view shot from track V1 to V2.

1. Select the V1 track only.

2. On the V1 track, place the position indicator within the intervu: 
LowellÕs Boat Shop shot in the Timeline and click the Mark Clip 
button under the Record monitor.

The intervu: LowellÕs Boat Shop shot is highlighted.

3. To add a new video track, choose New Video Track from the Clip 
menu on the toolbar.

4. Click the red Segment Mode (Lift/Overwrite) button below the 
Timeline.

5. Hold down the Command key and click and drag the intervu: 
LowellÕs Boat Shop clip to the track above, V2. 

The clip appears on track V2.

6. Click the Segment Mode (Lift/Overwrite) button again to deselect 
it.

7. Select track V2 and its monitor.

Creating the Picture-in-Picture Effect

To create the picture-in-picture effect:

1. Select the V2 track and its monitor.

2. Choose Effect Palette from the Tools menu.

The Blend effects, including Picture-in-Picture, are displayed in 
the right window.
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3. Place the position indicator anywhere in the intervu: LowellÕs 
Boat Shop clip on V2.

4. Click and drag the Picture-in-Picture Effect icon from the Effect 
Palette to the intervu: LowellÕs Boat Shop shot on track V2.

The Effect icon appears in the Timeline.

The boat shop owner appears in a box mid-screen.

Effect icon

Effect icon
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Repositioning the Image

LetÕs move the image to the lower left corner of the screen.

1. In the Timeline, move the position indicator directly over the effect 
icon.

2. Click the Effect Mode button to enter Effect mode.

Parameters for the Picture-in-Picture appear in the Effect Editor.

Foreground
image (V2)

Background
filler (V1)
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3. Click the image of the boat shop owner. Drag handles (the dots at 
the edges and in the middle of the box) appear, and a white hand 
appears when the mouse is over a handle.

4. Click the drag handle in the middle of the picture and drag the 
image to the lower left corner of the screen.

Adjusting a Parameter

Now letÕs use one of the Picture-in-Picture parameters to soften the 
edge of the image.

1. From the Effect Editor, click the Soft slider.

2. Drag the Soft slider to the right to a value of 30.

You can also enter 30 in the numeric keypad.

3. Click the Play Preview button in the Effect Editor to view the 
effect.

You can click the mouse button or press the space bar at any time 
to stop.

Soft slider

Play Preview button

Add Key
Frame button
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Adding Key Frames

To add dissolves within the Picture-in-Picture effect, you need to add 
key frames. These let the system know this is the location in the Pic-
ture-in-Picture effect you want to start the dissolve.

1. Choose V1 from the timecode track menu.

2. In the Record monitor, click the Þrst key frame.

3. Drag the Level slider all the way to the left to display 0.

4. Type +1:00 on the numeric keypad and press Enter to move the 
position indicator one second after the Þrst key frame.

5. Click the Add Key Frame button.

6. Drag the Level slider all the way to the right to display 100.

7. Click the mouse button on the last key frame.

8. Drag the Level slider all the way to the left to display 0.

9. Type -15 on the numeric keypad and press Enter to move the posi-
tion indicator 15 frames before the last key frame.

10. Click the Add Key Frame button.

11. Drag the Level slider all the way to the left to display 0.

12. Return to Source/Record mode by clicking the Source/Record 
mode button.

Last Key 
Frame

First Key
Frame
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Adding Background Images

In this section youÕll have the opportunity to add a background image 
on track V1, below the intervu: LowellÕs Boat Shop image.

1. Select track V1 and its monitor and deselect V2.

2. Place the position indicator in the Þller just above and below the 
intervu: LowellÕs Boat Shop clip in V1 track.

3. Click the Segment Mode (Extract/Splice-in) button.

4. Press k-X.

This removes the Þller and adds the three clips at the end of the 
sequence as your background to the picture-in-picture.

5. Select the V2 track.

6. Click the dories to model and Shift-click the sign clips on the A2 
audio track.

7. Press k-X to delete the excess audio.

8. Click the Segment Mode (Extract/Splice-in) button again to dese-
lect it.

9. Play your sequence through.

Rendering the Effect

You must render the Picture-in-Picture effect to play it at full speed.

1. Place the position indicator on the Effect icon in intervu: LowellÕs 
Boat Shop.

2. Select track V2.

3. Click the REND EFFE (Render Effect) button in the Fast menu 
below the Record monitor or choose Render at Position from the 
Clip menu.

The Render Effect dialog box appears.
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4. Select a disk drive in the Render Effect dialog box and click OK.

The Effect Source Disk is the default disk for storing the rendered 
effect.

5. After the effect is rendered, close the Effect Palette.

6. To save your work, choose Save All Bins from the File menu.

Screening the Sequence

YouÕve done a lot of work. Now take a look at the sequence.

1. Move the position indicator to the beginning of the sequence.

2. Select the V2 monitor.

3. Click Play. 

YouÕve Þnished this tutorial. You can go on to Tutorial: Creating Titles 
on page 169, or exit Media Composer.
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CHAPTER 9

Creating Titles

You can create a new title with the Title Tool and save the title in a bin, 
or add a new video track to the Timeline if you want the title to appear 
over video. This is described in the following sections:

¥ Creating New Titles

¥ Understanding the Title Tool Window

¥ Working with Text

¥ Text Formatting Tools

¥ Choosing Colors and Setting Transparency

¥ Saving Titles

¥ Editing a Title into a Sequence

Tutorial: Creating Titles contains the following sections:

¥ Adding a Title

¥ Saving a Title

¥ Closing the Title Tool

¥ Editing the Title into the Sequence

¥ Adding Rolling Credits
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Creating New Titles

You can create a new title with or without a sequence in the Timeline. 
However, if you want to create a title with a video background, you 
can load a video clip into the Record monitor to use as a reference 
frame while you create the title. The video reference frame you select 
appears in the background of the Title Tool while you create the title. 
The reference frame makes it easier to position text and objects exactly 
where you want them and to select colors from the frame to use in the 
text and objects.

Because the Avid Composer system automatically loads the new title 
into the Source monitor, you can immediately use the standard editing 
procedures to edit the title into your sequence. If you create multiple 
titles in the same Title Tool session, the system loads the last title you 
create into the Source monitor.

n After you create a title with a particular video format (PAL or NTSC), if you 
want to create a title for a project using the other video format, you must exit 
and restart the Avid Composer system.

The Avid Composer system saves into a bin each title you create. You 
can load a title into the Source monitor at any time or drag the Title 
Effect icon from the bin to a segment in the Timeline. You can also drag 
a title from the bin onto an existing title in the Timeline; this causes the 
existing title to be replaced. 

n The procedures described in this section use a video reference frame to create a 
title.
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Understanding the Title Tool Window

The Title Tool window has several major components: 

¥ The tool bar at the bottom of the screen

¥ A video or color background

¥ The title that you create

¥ The safe title and safe action area guidelines. For more informa-
tion, see ÒSafe Title/Action AreaÓ in the online help index.

The following illustration shows a title over a video background:

Tool bar

Safe action
area

Video
background

Safe title
area

Title
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Working with Text

By default, the Text Tool is active when you open the Title Tool. Click 
in the tool at the position where you wish to begin entering text.

To use the Text Tool at any other time, click the Text Tool icon, click 
anywhere within the title frame, and begin typing. A blinking vertical 
bar indicates your cursor position in the frame.

The Text Tool remains selected until you select another tool.

Text Formatting Tools

The text formatting tools control the appearance of text. If a text object 
is selected when you change an attribute, the Avid Composer system 
automatically applies the attribute to the object.

Text Tool

Text formatting tools
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The text formatting tools allow you to change the following text 
characteristics: 

¥ Current font

¥ Bold and italic

¥ Point size 

¥ JustiÞcation 

¥ Kerning

¥ Leading

This section describes how to change these characteristics on a text 
string basis. You can also change these attributes on a character-by-
character basis by editing the text string. For more information, see 
ÒTitles:text for, working withÓ in the online help index.

You can also modify the following text attributes on a text string basis:

¥ Color

¥ Transparency

¥ Drop and depth shadows

¥ Outlines surrounding text

While you type text, only the text color is apparent. Shadows, outlines, 
and other color attributes appear when you Þnish typing the text and 
click the Selection Tool.

n If you have multiple text elements in a title, and you want to give each ele-
ment a different appearance, create separate text strings.
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Choosing Colors and Setting Transparency

You can select the color and transparency for objects, shadows, and 
borders.

The following illustration shows the boxes associated with color and 
transparency:

¥ The Color selection boxes control the Þll (Fill), shadow (Shad), and 
border (Bord) color selection.

¥ The Transparency selection boxes control the Þll, shadow, and bor-
der transparency selection.

¥ The Blend and Transparency preview windows appear when you 
select the Þll or border color or transparency selection box.

If you select a color selection box, the top windows show the two 
colors that are used to create the blend. The bottom window 
shows the blended color and allows you to control the direction of 
the blend or transparency.

If you select a transparency selection box, the top windows show 
the two transparency values that are used to create the blend. The 
bottom window allows you to control the direction of the trans-
parency blend.

Blend and Transparency preview

Transparency selectionColor selection
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Adjusting the Color

To select a color from the Title Tool Color Picker, use an eyedropper to 
select a color from any open application on your computer, or use the 
Macintosh Color Picker to select a color. All of these features are avail-
able through the Title Tool Color Picker (see Figure 9-1).

Figure 9-1 Title Tool Color Picker

The Title Tool Color picker allows you to select object, shadow, or out-
line color. The box you use controls whether the color applies to an 
object, creates a colored shadow, or places a colored outline around the 
selected object.

Color selection bar

Shade selection palette

Original Color window

New Color window

Grayscale
selection bar

Eyedropper

Select to open
Macintosh Color Picker
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Saving Titles

There are three basic ways to work with titles:

¥ Create a new title by choosing New Title from the Clip menu.

¥ Edit an existing title by Control-double-clicking a Title Effect icon 
in a bin.

¥ Edit an existing title that is in a sequence.

The main difference between the three methods is that you can use 
Save As for the Þrst two but you cannot use Save As for the third 
method. 

Editing a Title into a Sequence

After you have created a title with the Title Tool, you can use one of 
the following two methods to edit the title into your sequence:

¥ Method 1: Add a new video track, load the title into the Source 
monitor, mark an IN point and an OUT point, and splice/over-
write the title into the sequence.

¥ Method 2: In Segment mode, drag the Title Effect clip from the bin 
to an existing segment in the Timeline between the edit points.

You edit titles into a sequence by using the same editing procedures 
you use for video. The only difference is that if you want to key the 
title over video, you must add a new video track.
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Tutorial: Creating Titles

In this tutorial you create a title and edit and add a rolling credit to the 
end of the sequence. This section corresponds to the clips and 
sequence in the bin titled Creating Titles.

n Be sure to read the preceding overview sections of this chapter before you start 
this tutorial.

Table 9-1 Starting the Tutorial: Creating Titles

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the Creating 
Ttiles bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the sequence you were 
working on from the previous 
tutorial into the Creating 
Titles bin. Close the Adding 
Effects bin.

2. From the Boat Shop Project 
window double-click the Add-
ing Effects bin and the Creating 
Titles bin to open them.

2. Click and drag the Creating 
Titles Sequence into the 
Composer monitor to begin the 
tutorial.

3. Drag the sequence you 
were working on from the 
Creating Titles bin into the 
Composer monitor.

3. Press the Option key and drag 
the sequence you were working 
on from the previous tutorial 
into the Creating Titles bin. 
Close the Adding Effects bin.

4. Drag the sequence you were 
working on from the Creating 
Titles bin into the Composer 
monitor.
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Adding a Title

Once you create and add a title to your sequence, you can reposition it, 
change the text color, adjust the font and point size, add a shadow or 
border, adjust levels and kerning, and bold or italicize it. 

Creating a New Title

To create a new title:

1. In the Record monitor, place the blue position indicator on the 
bridge clip in the sequence.

2. Choose New Title from the Clip menu.

The Title Tool window opens.

3. Click the Text Tool button. If it is already selected on the tool bar, 
the cursor becomes an I-beam when you click in the Title Tool 
window.

4. Click in the water below the bridge.

A blinking insertion point appears.

5. Type The Dory.

6. Click the Selection Tool on the tool bar.

Object selection handles surround the title.

7. Choose 72 for the point size.

8. Change the font to Palatino.

9. Click B for bold if itÕs not already selected.
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n You might want to drag the right side of the text selection box to eliminate 
any unused space, especially if you want to use the Alignment menu com-
mands. To drag the right side, click the middle handle on the right side of the 
text selection box and drag it to the left until it is closer to the text.

Repositioning Text

Option-click anywhere in the Title Tool window to switch between the 
Selection Tool and the Text Tool.

1. With the Selection Tool selected, click and drag the title so that it 
appears across the water.

2. Use the arrow keys to move the title more precisely.

Selection
Tool

Font Point size Fill box Shadow Depth box
Bold
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Changing Color

1. Click and hold the Fill box. 

The Macintosh Color Picker appears.

2. Click a blue color.

The color is applied to the title.

Adding a Shadow

Enter a value of 3 in the Shadow Depth box.

Saving a Title

To save your title:

1. Choose Save Title from the File menu.

A dialog box appears.

2. Type The Dory in the name text box.

3. Choose the Creating Titles bin and a target disk to store your title.

4. Click OK.

Closing the Title Tool

Click the close box. The title appears in the Source monitor and in the 
bin where you chose to save it.
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Editing the Title into the Sequence

To add your title to your sequence:

1. Turn the V2 track on and turn V1, A1, and A2 off.

2. Click and drag the V1 source track to the V2 record track.

3. With the title clip loaded in the Source monitor, set an IN mark at 
the beginning of the clip and an OUT mark at 1:00:02:15.

4. In the Timeline, move the position indicator to 1:00:00:06.

5. Click the Overwrite button.

This adds the title to the V2 video track.

6. Play the sequence to see your title.

Adding Rolling Credits

You can create a title in the Title Tool and then make it scroll vertically; 
this is known as a rolling title. You can also scroll horizontally; this is 
known as a crawling title.

Editing an Existing Title

To edit an existing title:

1. In the bin, Control-double-click the RollingTitle: Credits clip to 
open it in the Title Tool.



174

2. Drag the cursor over the entire Your Name text to select it.

3. Type in your name.

4. Click the close box.

A dialog box appears.

5. Click Save.

Two titles appear in the bin (the old title and the new title you just 
edited).

Adding a Video Background
1. Double-click the rowing in mist clip to load it into the Source 

monitor.

2. Clear any IN and OUT marks.

3. Turn on the V1 record track and turn off all others.

4. Drag the V1 source track to the V1 record track.

5. In the Timeline, move the position indicator to the end of the sign 
clip.

6. Click the Splice-in button.

The rowing in mist clip is added to the sequence.
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Viewing the Creation Date

Your edited title has the same name as the version originally in the bin. 
To distinguish the two, you can look at the creation date.

1. Click the Creating Titles bin to select it.

2. Choose Headings from the Bin menu.

3. Select creation date and click OK.

Editing a Title into a Sequence

To splice the title into your sequence:

1. Double-click the new Rolling Title: Credits title clip to load it into 
the Source monitor. The new credits clip (you created) will have a 
new creation date.

2. From the Source monitor, click the Play button to play through the 
rolling credit.

Black appears at Þrst, then eventually the credits appear.

3. Set an IN mark at 00:00:02:12.

4. From the numeric keypad type +33:09 and Enter, then click the 
Mark OUT button.

5. Drag the position indicator to the end of the intervu: LowellÕs 
Boat Shop clip on V2.

6. Select the V2 record track and turn off all other tracks.

7. Drag the V1 source track to the V2 record track.

8. Click the yellow Splice-in button.

The Rolling Title: Credits clip appears over the rowing in mist 
clip.

9. Press Play to view the rolling title over video.
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Deleting Excess Footage

There is excess footage that continues beyond the rolling title that we 
can delete. To do this:

1. Turn on the V1 record track.

2. In the Timeline, move the position indicator to the end of the 
Credits clip.

3. From the Fast menu, click the Add Edit button.

This creates a transition.

4. Click the Segment Mode (Lift/Overwrite) button at the bottom of 
the Timeline.

5. On the V1 track, click the last clip (the second rowing in mist clip) 
in the Timeline to select it.

6. Press the Delete key.

The clip is deleted.

7. Save your project and bins and play the sequence.

Exiting the Title Tool After Creating a New Title

To exit the Title Tool, click the close box.

YouÕve Þnished this tutorial. You can go on to Tutorial: Output on 
page 181, or exit Media Composer.
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CHAPTER 10

Output

Media Composer provides tools for generating output for individual 
tracks or entire sequences to various videotape or audiotape formats. 
In addition, you can generate an edit decision list (EDL) to be used by 
editors in a videotape suite for preparing a master tape. This is 
described in the following sections:

¥ Output Options

¥ Preparing for Output

¥ Digital Cut

¥ Supported File Types for Export

¥ Preparing to Export

Tutorial: Output contains the following section:

¥ Recording a Digital Cut to Tape
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Output Options

Media Composer provides tools for generating output for individual 
tracks or entire sequences to various videotape or audiotape formats. 
In addition, you can generate an EDL to be used by editors in a video-
tape suite for preparing a master tape. You can also use VTR emulation 
for direct playback of sequences using an edit controller in an analog 
editing suite.

Preparing for Output

Preparing for video output involves the following procedures:

¥ Render all non-real-time effects, as described in the Avid Media 
Composer and Film Composer Effects Guide.

¥ Calibrate and adjust video output levels (see ÒVideo:output, cali-
brating (basic or advanced)Ó in the online help index).

¥ Calibrate and adjust audio output levels (see ÒAudio output:pre-
paring forÓ in the online help index).

For more information 
on mixing down audio 
tracks, see 
ÒAudio:tracks, mixing 
downÓ in the online 
help index.

¥ Decide whether you want to generate stereo or mono audio.

¥ Mix down multiple audio tracks if necessary. Systems equipped 
with a two-channel audio board can generate a maximum of two 
channels. Systems equipped with the Digidesign audio interface 
can generate a maximum of four channels.

¥ (Optional) Select settings for direct four-channel audio output (see 
ÒFour-channel audio:output, generatingÓ in the online help 
index).

¥ Prepare the record tapes.

¥ (Optional) Record reference bars and tone to tape.
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Digital Cut

The Digital Cut Tool provides frame-accurate control when recording 
a sequence to tape. You can also use the Digital Cut Tool to preview 
the sequence with a computer-generated countdown.

If you have a Media 
Reader connected to 
your system, you can 
create burn-in timecode 
on the digital cut. For 
more information, see 
the Avid Media Reader 
Setup and UserÕs Guide.

The Digital Cut Tool provides several options for managing the 
recording of your sequence. For example, you can:

¥ Record using either assemble or insert edits.

¥ Record a selected portion of the sequence or selected tracks.

¥ Record according to different timecode parameters.

Supported File Types for Export

There are several reasons why you might want to export video, audio, 
or both from the Media Composer system: 

¥ You can export audio Þles for audio sweetening in compatible 
applications.

¥ You can export video Þles for touching up or creating special 
effects in third-party applications.

¥ You can export Þles compatible with CD-ROM for use in multime-
dia projects.

¥ You can export Þles to be viewed as a Quicktime¨ Codec movie.

You can export Þles in the following formats: 

¥ Shot log

¥ PICT

¥ QuickTime

¥ OMF Interchange¨
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Preparing to Export

If you are exporting part or all of a sequence, you can speed the export 
process by preparing the sequence in advance as follows:

See the Avid Media Com-
poser and Film Composer 
Effects Guide for more 
information on render-
ing.

¥ Render all effects in advance. Although any unrendered effects are 
rendered on export (except for an OMF export), rendering effects 
in advance saves you time.

¥ Consider mixing down additional tracks in advance, see 
ÒVideo:performing mixdownÓ and ÒAudio:performing mixdownÓ 
in the online help index.

¥ Check and adjust all pan and audio levels in advance, see ÒUsing 
the Audio Mix ToolÓ in the online help index. All current pan and 
level settings in the sequence are carried through to the exported 
media.

¥ If you are exporting an OMF Þle, remember that OMF does not 
mix down the tracks in a sequence during export. OMF maintains 
all editing information in your sequence, allowing changes later. 
Media Composer mixes down video for PICT and QuickTime for-
mats and audio for PICT formats.

¥ If you are exporting an OMF Þle, consider consolidating the media 
to save time and disk space. See ÒConsolidating:mediaÓ and 
ÒTransferring:OMF Þles to AudioVisionÓ in the online help index.
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Tutorial: Output

In this tutorial you create a digital cut. This section corresponds to the 
clips and sequence in the bin titled Output.

n Be sure to read the preceding overview sections of this chapter before you start 
this tutorial.

Table 10-1 Starting the Tutorial: Output

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the Output 
bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the sequence you were 
working on from the previous 
tutorial into the Output bin. 
Close the Creating Titles bin.

2. From the Boat Shop Project 
window double-click the Creat-
ing Titles bin and the Output 
bin to open them.

2. Click and drag the Output 
Sequence into the Composer 
monitor to begin the tutorial.

3. Drag the sequence you 
were working on from the 
Output bin into the Com-
poser monitor.

3. Press the Option key and drag 
the sequence you were working 
on from the previous tutorial 
into the Output bin. Close the 
Creating Titles bin.

4. Drag the sequence you were 
working on from the Output bin 
into the Composer monitor.
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Recording a Digital Cut to Tape
1. Choose New Deck Controller from the Tools menu. Use the deck 

controller to cue and the record tape during Digital Cut recording.

2. Load the Boat Shop sequence (or Output Sequence) into the 
Record monitor. 

3. Choose Digital Cut from the Output menu.

The Digital Cut Tool appears.

4. Select the Entire Sequence option based upon the following:

¥ Select the Entire Sequence option if you want the system to 
ignore any IN or OUT marks and play the entire sequence 
from start to Þnish.

¥ Deselect this option if you have established IN and/or OUT 
marks for recording a portion of the sequence.

5. Choose an option from the Record to Tape pop-up menu as 
follows:

¥ Choose Sequence Time to start the recording at a timecode 
existing on tape that matches the start timecode of the 
sequence.   If you intend to record several sequences to tape 
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one after another, this option requires resetting the start time-
code on each sequence to match appropriate IN points on the 
tape.

¥ Choose Record Deck Time to ignore the timecode of the 
sequence, and start the recording wherever the record deck is 
currently cued.

¥ Choose Mark In Time to ignore the sequence timecode and 
establish a speciÞc IN point on the record tape.

6. Select the audio and video tracks you want represented in the dig-
ital cut. Only those tracks beside and beneath the speaker icon and 
the monitor icon are included in the digital cut.

The display of tracks in the Digital Cut window varies according 
to the tracks existing in the sequence.

7. Press Play.

The system cues the record deck, then plays and records the digi-
tal cut. The playback appears in the Record monitor and the full-
screen monitor.

8. To stop the recording at any time, press the space bar.

n After assemble-edit recording, a freeze frame is usually added after the OUT 
point for one or more seconds, depending upon the record deck model. This 
provides several frames of overlap for the next IN point, before control track 
and timecode break up.

YouÕve Þnished this tutorial. You can go on to Tutorial: Backing Up on 
page 193, or exit Media Composer.
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CHAPTER 11

Backing Up

When you digitize footage, the system creates digital media Þles for 
the video and audio tracks on the media drives attached to your sys-
tem. Media Composer provides useful tools and features for directly 
managing media Þles for storage and playback, backup and transfer 
between systems. This is described in the following sections:

¥ About Media Files

¥ Basic Media Tool Features

¥ Freeing Storage Space

¥ Consolidating Media

¥ Backing Up Media Files

¥ Backing Up Project Folders

Tutorial: Backing Up contains the following sections:

¥ Using the Consolidate Command

¥ Saving Your Work on a Disk or Drive

¥ Restoring from a Backup

¥ Quitting and Shutting Down
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About Media Files

The system stores the media Þles created during digitizing in folders 
on your media drives labeled OMFI MediaFiles (or 6.x MediaFiles if 
you are using an earlier release of the Media Composer software).

Media Þles are created in the following circumstances:

¥ During digitizing, a media Þle is created for each selected track 
(for example, V1, A1, A2), and they all are linked to the master 
clip.

¥ When you render effects, the system creates effect media Þles, oth-
erwise known as precomputes, that are linked to the effect clip.

¥ When you create subclips and sequences, you do not create new 
media Þles. These refer to the media Þles for the source master 
clips.

To manage media Þles, the system also creates a Database Þle that is 
stored in each MediaFiles folder. The system updates the Database Þle 
each time you make a change to a media Þle.

The following illustration shows the links among media Þles (stored 
on the media drives), the various clips (stored in the bin Þles in the 
Composer Project folders on the Avid drive), and an edited sequence 
(shown in the Timeline and stored in the bin).
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Media Objects and Files

Drives

Desktop files

Media Composer 

Media drive files Avid (internal) drive files

OMFI MediaFiles Composer Projects

Bin
Media Database

Precompute media file
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Media Relationships

Table 11-1 displays the Media File icon and a description of each icon.

Table 11-1 Media Objects and Files

Object Icon Object Description

Source Clip
A clip that references the original videotape source 
footage for master clips.

Master Clip A clip that references audio and video media Þles 
formed from digitized footage or imported Þles.

Subclip
A clip that references a selected portion of a master 
clip.

Sequence
A clip that represents an edited program, partial or 
complete, that you create from other clips.

Group clip
A Þle in the bin that combines two or more clips 
based on marks or tracking info sync points.

Motion effect
A Þle in the bin that references effect media Þles 
generated when you create motion effects.

Rendered effect
(precompute)

A clip that references an effect media Þle generated 
when you render an effect.

Effect and Title
A clip that references an unrendered effect that you 
create.

Multigroup clip
(For multicamera editing) A clip containing two or 
more grouped clips, strung together sequentially 
according to common timecodes.
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Basic Media Tool Features

The Media Tool provides many of the same controls for viewing and 
managing information that you use with bins, including the following:

¥ Three display modes in the Media Tool function like those in bins: 
Text mode, Script mode, and Frame mode.

¥ The Media Tool Fast menu gives you quick access to all the same 
commands available in the Bin Fast menu.

¥ You can highlight, move, copy, duplicate, delete, and sift clips. You 
can also select media relatives, sources, and unreferenced clips.

¥ You can use Text mode headings and display options for columns 
of clip and media Þle data. You can also use procedures such as 
customizing the display of columns, moving within columns, and 
sorting information described in ÒMedia Tool:comparing with 
binsÓ in the online help index.

¥ You can use the same Frame mode display options described in 
ÒAbout Bin Display ModesÓ on page 64.

¥ You can use the same Script mode display options described in 
ÒAbout Bin Display ModesÓ on page 64.

¥ You can print Media Tool data using the same procedures for 
printing bins, described in ÒBins:printingÓ in the online help 
index.

Media Þle
A Þle on the media drive containing digital audio 
or video material. Media Þles are formed when you 
digitize footage or import Þles, mix down audio or 
video tracks, create an effect (precompute media 
Þle), or render an effect.

Table 11-1 Media Objects and Files

Object Icon Object Description
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In addition to the procedures just described, the Media Tool has a 
number of unique functions, described in this section. These include 
the following:

¥ Unlike bins, the Media Tool displays all the tracks digitized for 
each clip as separate media Þles. Therefore, when you view, delete, 
and manipulate Þles, you have the added option of specifying 
individual video and audio tracks.

¥ The Media Tool does not display sequences and subclips. Only 
master clips, precompute (rendered effect) master clips, and asso-
ciated media Þles are displayed.

¥ The following Bin and Clip menu commands do not apply to the 
Media Tool: Modify, Select Ofßine Items, and Relink. You must 
perform these functions from the bin.

¥ The Media Tool database and display options are not saved as 
they are with bins. Instead they are re-created each time you open 
the tool. Likewise, when you close the Media Tool, any customiza-
tion of columns or other views elements is deleted.

Freeing Storage Space

Unlike the bin Þles stored in project folders on the Avid drive, media 
Þles require considerable storage space. To maximize your use of stor-
age during larger projects, you can abridge and/or convert media 
Þles. You can perform these procedures on clips selected in either the 
Media Tool or in bins. 

In addition, you can delete unreferenced media Þles for a Þnished 
sequence. This procedure is performed on clips selected in bins only.
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Consolidating Media

When you consolidate media Þles, the system Þnds the media Þles or 
portions of media Þles associated with selected clips, subclips, or 
sequences. It then makes copies of them, and saves the copies on a tar-
get disk that you specify. Because the Media Tool displays only master 
clips, you cannot consolidate subclips or sequences with the Media 
Tool. You can consolidate master clips, subclips, and sequences in the 
bin.

About the Consolidate Feature

For illustrations of the 
different types of con-
solidation, see the Avid 
Media Composer and Film 
Composer Quick 
Reference.

The Consolidate feature operates differently depending upon whether 
you are consolidating master clips, subclips, or sequences. There are 
also different advantages in each case, as follows:

¥ Master clips: When you consolidate a master clip, the system cre-
ates exact copies of the media Þles. If you link the original master 
clip to the new Þles, the system creates a master clip with the 
extension .old that remains linked to the old Þles. If you choose to 
maintain the link between the original master clip and the old 
media Þles, the system creates a new master clip with the exten-
sion .new that is linked to the new Þles. The new clips are also 
numbered incrementally beginning with .01. Consolidating mas-
ter clips does not save storage space because the system copies the 
same amount of media for each clip.

¥ Subclips: When you consolidate a subclip or group of subclips, 
the system copies only the portion of the media Þles repre-
sented in the subclip, and creates a copy of both the master 
clips and the subclips. The sufÞx .new is attached, along with 
incremental numbering beginning with .01.

¥ Sequences: When you consolidate a sequence, the system copies 
only the portions of media Þles edited into the sequence, and cre-
ates new master clips for each shot in the sequence. The sufÞx 
.new is attached to the master clips, along with incremental 



191

numbering beginning with .01. The sequence is not renamed, 
but is automatically relinked to the new media Þles.

n Because a consolidated sequence is linked to the new Þles by default, consider 
duplicating the sequence each time you consolidate if you need to maintain 
links to the original Þles.

Backing Up Media Files

The MediaFiles folders on your external media drives contain the indi-
vidual media Þles created when you digitize source material. Unlike 
the smaller Composer Project and Avid User folders, these folders are 
too large to back up onto diskettes.

The following are the options for backing up media Þles:

¥ You can use the Consolidate feature, described in ÒConsolidating 
MediaÓ on page 190, to make copies of selected media Þles on a 
target hard drive connected to the system.

For information on 
archiving procedures, 
see your AVIDdrive 
DLT documentation. 
For information on pur-
chasing AVIDdrive 
DLT, contact your Avid 
sales representative.

¥ You can archive larger media Þles and folders to a dedicated mass-
storage system, such as AVIDdrive DLT (digital linear tape).

¥ You can consolidate or make copies of media Þles for transfer to 
another system. For more information, see ÒConsolidating:mediaÓ 
in the online help index.
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Backing Up Project Folders

To back up the larger 
media Þles that are cre-
ated when you digitize 
footage, you must use a 
mass-storage device 
such as the Avid digital 
linear tape (DLT) 
device. For more infor-
mation, see the Avid 
DLT Tape Drive Setup 
and UserÕs Guide.

Although Media Composer automatically saves your bins, projects, 
and settings, you should back up these items frequently to avoid los-
ing any of your work in case of a hard drive crash or corruption of the 
Þles. Because the storage requirements are minimal, you can back up 
these Þles easily to a variety of storage devices, such as:

¥ Diskette

¥ Network storage device, such as a Þle server

¥ Mass storage device
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Tutorial: Backing Up

In this tutorial you learn to back up and free up space on your media 
drive. This section corresponds to the clips and sequence in the bin 
titled Backing Up.

n Be sure to read the preceding overview sections of this chapter before 
you start this tutorial.

Table 11-2 Starting the Tutorial: Backing Up

If you have worked on the 
previous tutorial and 
Media Composer is still 
running:

If you have worked on the 
previous tutorial but have 
quit the Media Composer 
system:

If you are just starting out 
with this tutorial and 
havenÕt completed the 
previous tutorials:

1. Double-click the Backing 
Up bin to open it.

1. Launch Media Composer by 
double-clicking the application 
icon.

1. Launch Media Composer by 
double-clicking the application 
icon.

2. Press the Option key and 
drag the Boat Shop sequence 
you were working on from 
the previous tutorial into the 
Backing Up bin. Close the 
Output bin.

2. From the Boat Shop Project 
window double-click the Output 
bin and the Backing Up bin to 
open them.

2. Click and drag the Backing 
Up Sequence into the 
Composer monitor to begin the 
tutorial.

3. Drag the sequence you 
were working on from the 
Backing Up bin into the Com-
poser monitor.

3. Press the Option key and drag 
the Boat Shop sequence you 
were working on from the previ-
ous tutorial into the Backing Up 
bin. Close the Output bin.

4. Drag the sequence you were 
working on from the Backing 
Up bin into the Composer moni-
tor.
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Using the Consolidate Command

To consolidate the Boat Shop sequence:

For more information 
on rendering effects, see 
the Avid Media Composer 
and Film Composer 
Effects Guide.

1. Select the Boat Shop sequence (or Backing Up Sequence).

2. Choose Duplicate from the File menu.

This allows you to maintain links to the original Þles, if necessary, 
and render any unrendered effects.

3. Choose Consolidate from the Clip menu. 

The Consolidate dialog box appears.

4. Choose one of the following:

¥ ÒDelete original media Þles when doneÓ to delete original 
media Þles automatically.

¥ ÒSkip media Þles already on the target diskÓ if some related 
media Þles are already located on the target disk.

¥ ÒRelink selected clips to target disk before skippingÓ to ensure 
that all selected clips are linked to media on the target drive. 
This option appears when you select ÒSkip media Þles already 
on target disk.Ó

5. Choose a target disk from the pop-up menu.
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Make sure that you choose a target disk with enough storage 
space for all the consolidated media Þles.

6. Enter a handle length for the new clips in the entry Þeld, or leave it 
at 60 frames to accept the default.

7. Click OK.

If you did not choose to delete the original media Þles, a second 
dialog box appears and offers you a choice.

8. Link the original master clips to the new or old media Þles, accord-
ing to preference.

9. Click OK.

Another way to back up media Þles is to copy them directly onto 
another hard drive in the Finder. You cannot, however, take advantage 
of the storage-saving features of the Consolidate command, and it is 
more difÞcult to identify particular media Þles when searching 
directly through folders.

c Do not make copies of media Þles in the Finder while Media 
Composer is running. Also, do not keep duplicate copies of media 
Þles online; either delete the originals, take the backups ofßine, or 
store the backups in a folder with a different name.
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Saving Your Work on a Disk or Drive

To save your work on a diskette or drive:

1. Mount or insert the drive or diskette as appropriate.

2. Double-click the icon for the targeted storage drive or diskette to 
open it. Double-click any additional folders to target the appropri-
ate storage location.

3. Double-click the Avid drive to open it.

4. Drag a project folder, user folder, or Settings Þle to the targeted 
storage location.

5. When the system Þnishes copying the Þles, eject the diskette or 
drive and store it when appropriate.

Restoring from a Backup

To restore a project, user proÞle, or settings from a backup storage 
device: 

1. Mount or insert the drive or diskette as appropriate.

2. Open the drive or diskette, and the Avid drive.

If you are restoring an 
individual bin or bins, 
you must relink them to 
the project from within 
the Project window. For 
more information, see 
ÒMedia Þles:relinkingÓ 
in the online help index.

3. Drag the copies from the storage device to the appropriate folder 
on the Avid drive:

¥ Project folders and settings Þles go in the Composer Projects 
folder.

¥ User folders and settings Þles go in the Avid Users folder.

¥ Site settings Þles go in the Media Composer folder.

4. Launch the Media Composer application. The restored project/
user proÞle appears in the Project Selection dialog box.
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Quitting and Shutting Down

To quit and shut down:

1. Click Quit in the Project Selection dialog box.

2. Choose Leave when the system prompts you.

3. Choose Shut Down from the Special menu.

4. After a few seconds, turn off the rest of your hardware.

Summary

Congratulations on completing the Avid Media Composer Tutorial! 
We hope youÕve enjoyed this introduction to the Avid editing process. 
After mastering these skills, you can proceed to learn more advanced 
techniques for inputting media, adding other effects and titles, and 
outputting work for digital cuts or EDLs.

For further information about any Media Composer techniques or fea-
tures, see the online help system or the Avid Media Composer UserÕs 
Guide.

Avid also recommends that you consult the latest Avid Training
Catalog for complete descriptions and schedules of AvidÕs course 
offerings. All classes are led by trained, experienced professionals. A 
variety of hands-on student activities encourage participant learning. 
Call 800-867-2843 for more information.
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A
Add Dissolve button (Fast menu) 150, 151
Adding audio 138
Adding shots to a sequence 110
Adjusting

audio hardware 57
hue and saturation 59
luminance 59
volume 139

Adobe Photoshop 143
Agreeing to electronic license 30
Alias, launching an application from 29
Analog VU scale (Audio Input Tool) 58
Applying effects 146
Arrow keys, jogging with 71
A-side (outgoing frames), in trims 117
Audio

adding 138
locating specific frame 101
tracks, monitoring 98

Audio Monitor buttons (Track Selector panel) 
68

Audio Tool 57
Autodigitizing 61
Avid Composer system, launching the 

application 29
Avid Users folder, described 43

B
Backing up

media files 191
project folders 192

Basic settings 46
Batch digitizing 62
Big Trim mode, toggling between Small Trim 

mode 116
Bin display modes 64
Bin pop-up menu (Digitize Tool) 55
Bin settings, defined 46
Bin views 66
Bins

autosaving 162
defined 36
displaying in Project window 44
Frame view 77
Info Display 47
saving, using system backup 192
Text view 77
viewing clips in 76, 91

Bins display (Project window) 44
Black burst generator, turning on 23
Blue bar See Position indicator
B-side (incoming frames), in trims 117
Buttons

Add Dissolve (Fast menu) 150, 151

Index

A B C D E F G H I J K L M N O P R S T U V W 
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Audio Monitor (Track Selector panel) 68
Clear Both Marks 88
Cycle Picture/Sound (Command Palette) 98
Cycle Trim Sides (Command Palette) 117
Deck Offline (Digitize Tool) 56
Digitize (Digitize Tool) 56
Digitize/Log mode (Digitize Tool) 56
Fast Menu 150
Focus (Timeline) 95
Frame mode (Bin window) 65
Go to IN (Command Palette) 107
Go to Next Edit (Command Palette) 115
Go to OUT (Command Palette) 107
Go to Previous Edit (Command Palette) 115
In/Out (Audio Input Tool) 58
Internal Waveform Monitor (Video Input 

Tool) 59
Lift/Overwrite 132
Mouse Shuttle (Command Palette) 72
Mouse Step (Command Palette) 72
on Command Palette 119
Output (Audio Tool) 57
Overwrite 124
Play IN to OUT (Command Palette) 107
Play Loop (Command Palette) 115
Remove Effect (Fast menu) 153
Reset Peak (Audio Input Tool) 57
Review Transition 115
Script Mode (Bin window) 66
Setup (Audio Input Tool) 57
Single/Dual Drives (Digitize Tool) 56
Source/Record toggle 95, 95
Splice-in 102, 108
Step 69
Subclip (Source monitor) 74
Text Mode (Bin window) 64
Trash/Abort (Digitize Tool) 56
Trim A-side 117
Trim B-side 117
Trim Mode 114
using to control playback 68

Vectorscope (Video Input Tool) 59
Video Monitor (Track Selector panel) 68

C
Clear Both Marks button 88
Clip icon 74
Clips

exporting 179
marking 81
playing 68, 78
sorting by clip name 77
splicing 102
viewing 76, 91

Closing a project 88
Color Picker 167
Color selection boxes in Title Tool 166
Command Palette, using 119
Composer Projects folder, described 43
Composer system

application 29
overview 34

Consolidate command (Clip menu) 194
Consolidate dialog box 194
Consolidating media files 190, 194
Controlling playback 66
Controlling transparency 166
Countdown

customizing 179
in a digital cut 179

Creating
new user 51
subclips 74

Custom Time option (Digital Cut Tool) 183
Custom view 66
Cut list, defined 37
Cycle Picture/Sound button (Command 

Palette) 98
Cycle Trim Sides button (Command Palette) 

117
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D
Deck Configuration settings 54
Deck controls (Digitize Tool) 56
Deck Offline button (Digitize Tool) 56
Deck Selection pop-up menu (Digitize Tool) 56
Deck Settings 54
Deleting digitized media 56
Desktop, Composer elements on 24
Digidesign hardware, turning on 22
Digital audio scrub 101
Digital Cut Tool 179
Digital cuts

defined 37
previewing 179
Record to Tape options 183
recording 179

Digital VU scale (Audio Input Tool) 58
Digitize button (Digitize Tool) 56
Digitize Indicator (Digitize Tool) 56
Digitize settings 54
Digitize Tool 55
Digitize/Log mode button (Digitize Tool) 56
Digitizing 61
Digitizing and logging at the same time 61
Digitizing from a mark IN to a mark OUT 61
Digitizing on-the-fly 61
Digitizing preparations 60
Diskette, saving work on 192
Displaying digitizing status 56
Displaying project settings 45
Dissolves, creating a series of 152
DLT for backup 192
Drive, saving work on 196
Dual-roller trim 133 to 136

E
Editing

basics 35

components 36
nonlinear, defined 35
overview 40
preparing for 39
titles 168

EDL, described 41
Effect 144
Effect categories 144
Effect mode

defined 36
in workflow 40
working in 147

Effect Palette, displaying 144
Effect parameters

segment effects 145
transitions 145

Effect template 143
Electronic license 30
End key 71, 79
Ending the session 89
Entering Trim mode 114
Exiting Trim mode 116
Exporting files

preparing for 180
supported formats for 179

Extract/Splice-in tool 131, 132, 132
Eyedropper tool 167

F
Fade in, adding 150
Fast Forward button 68
Fast Forward button (Command Palette) 68
Fast Menu button 150
File formats for exporting 179
Fixed-storage drive, turning on 22
Focus button (Timeline) 95
Focusing the Timeline 95
Footage

marking IN and OUT 73
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rearranging 131
removing 132
viewing and playing 66 to 73

Frame Mode button (Bin window) 65
Frame offset 86
Frame view 77
Frames

finding with timecode 84
locating with digital audio scrub 101
title background in 162
using frame offset 86

Freeing storage space 189
Freeze Frame effect, accessing 144

G
General settings, defined 46
Go to IN button (Command Palette) 107
Go to OUT button (Command Palette) 107

H
Hardware, starting 22
Home key 71, 79
Hue, adjusting 59

I
IN and OUT points

clearing 88
defined 36
marking 73, 82 to 85

In/Out buttons (Audio Input Tool) 58
Info display (Project window) 47
Input button (Audio Tool) 57
Input pop-up menu (Video Input Tool) 59
Installing tutorial files 25
Interface settings, defined 47

Internal Waveform Monitor button (Video 
Input Tool) 59

J
J-K-L keys (Three-Button Play) 70, 79
Jogging See Stepping

K
Key frames, adding 158
Keyboard, using to control playback 69

L
Launching the application 29
Left Arrow key 71
License agreement, accepting 30
Lift/Overwrite button 132
Luminance, adjusting 59

M
Macintosh computer, turning on 23
Macintosh desktop 24
Marking clips

for storyboarding 125
using IN and OUT points 81, 82
using timecode 84

Masks, effect types 146
Master clips

consolidating 190
defined 36

Master timecode, displaying 103
Media files

backing up 191
consolidating
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defined 190
procedure 194

defined 36
Media Tool features 188
Memory See RAM
Memory window 49
Menu commands

Consolidate (Clip menu) 194
Digital Cut (Output menu) 179
Select All Tracks (Edit menu) 98

Meters (Audio Input Tool) 58
Monitor icons 98
Monitoring audio/video tracks 98
Monitors, viewing in 91
Motion effects, accessing 144
Mouse Jog button 71
Mouse Shuttle button (Command Palette) 72
Mouse Step button (Command Palette) 72
Mouse, using to control playback 71
Moving through clips 68
Multiple layer effects, defined 145

N
New Title command 170
Nonlinear editing, defined 35
Non-real-time effects 147
Numeric keypad 84, 86

O
Online help, accessing 31
Output

See also Digital cuts, EDL, Playback
options 178
overview 41
preparing for 178

Overwrite button 124
Overwriting shots 124, 129

P
Pause button 68
Peak Hold pop-up menu (Audio Input Tool) 58
Peripheral hardware, turning on 22
Picture tracks, monitoring 98
Picture-in-Picture effect

applying 153
defined 146

Play button 68, 80
Play IN to OUT button (Command Palette) 107
Play key 79
Play Loop button (Command Palette) 115
Playback, controlling

with buttons 68
with position bars and indicator 67
with the keyboard 69
with the mouse 71

Playing clips 69, 107
Pop-up monitor

splicing a clip into 105
viewing in 92

Position bar 67
Position indicator

in the Timeline 93
moving with frame offset 86
positioning for title creation 170
snapping to IN or OUT 108
using 67

Precompute 147
Preparing to digitize 60
Preparing to edit, overview 39
Previewing digital cuts 179
Project

closing 88
saving 192
selecting 51
workflow for 37

Project settings, defined 45
Project window

bins display 44
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Info display, using 47
Settings display (Project window) 45

Projects folder See Composer Projects folder

R
RAM 49
Random access to footage, defined 35
Real-time effects 147
Record Deck Time option (Digital Cut Tool) 183
Record monitor, viewing in 91
Recording digital cuts 179
Recording to the Timeline 56
Redigitizing 62
Remove Effect button (Fast menu) 153
Removing footage from a sequence 132
Rendering effects 147
Repositioning title text 171
Reset Peak button (Audio Input Tool) 57
Resetting peak measurements 57
Resolution pop-up menu (Digitize Tool) 56
Restoring files from backup 196
Review Transition button 115
Rewind button 68
Right Arrow key 71
Rollers See Trim mode
Rolling title, adding 173

S
Saturation, adjusting 59
Saving bins 192
Saving on a drive 196
Saving projects 192
Saving settings for video input 59
Scale bar in Timeline 94
Script mode 65
Script Mode button (Bin window) 66
Scroll bar in Timeline 94

Second Row of Buttons, displaying 149
Segment effect

applying 145
multiple layer effects 145
single layer effects 146
types of 145

Segment mode
defined 36
in workflow 40
using 113

Select All Tracks command (Edit menu) 98
Selecting

a project 51
Digitize settings 54
title colors 166
tracks for digitizing 55
tracks in the Timeline 97
transitions for trimming 114
trim sides 117

Sequence Time option (Digital Cut Tool) 183
Sequences

adding shots to 109
changing name of 102
consolidating 190
defined 36
dissolving between shots 152
editing a title into 168
editing, overview 40
exporting 179
output options for 178
playing 102
rearranging footage in 129
removing footage from 132
splicing into 104
title editing 168

Settings 45
Settings pop-up menu (Video Input Tool) 59
Setup button (Audio Input Tool) 57
Shuttling

with J-K-L keys 70
with the mouse 71
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Single/Dual Drives button (Digitize Tool) 56
Single-layer segment effects 146
Single-roller trim 137
Site settings, defined 46
Small Trim mode, toggling between Big Trim 

mode 116
Source clips

defined 36
in workflow 39

Source material, displaying in Timeline 95
Source monitor

marking edit points in 73, 83
playing clips in 68, 78
viewing clips in 91

Source/Record mode
defined 36
in workflow 40

Source/Record toggle button (Timeline) 95
Splice-in button 102, 108
Splicing a shot 108
Splicing an audio clip 102
Splicing video into audio 103 to 111
Starting a project, overview 38
Status bar (Digitize Tool) 56
Step buttons 69
Stepping

with buttons 69
with mouse 71
with the keyboard 70

Storyboard editing 127
Storyboard, defined 39
Subclip button (Source monitor) 74
Subclip indicator (Digitize Tool) 56
Subclipping 87
Subclips

consolidating 190
creating 74
defined 37
handle (dot) 74
in workflow 40

Switching between digitize mode and log mode 
56

T
Tape drive, backing up on 192
Tape Name display (Digitize Tool) 56
Target Drive pop-up menus (Digitize Tool) 56
Text for titles, repositioning of 171
Text formatting tools 164
Text Mode button (Bin window) 64
Text Tool, working with 164
Text view 77
Three-button play See J-K-L keys
Three-point edit 129
Timecode, using as reference for marking 84
Timeline

defined 36
focusing 95
lassoing transitions in 114
monitoring tracks in 98
position indicator 93
scroll bar 93
segment editing of titles 168
source material, displaying 95
title development 162
Track Selector panel 96
viewing in 92

Title text, repositioning 171
Title Tool

creating a new title with 162 to 170
creating multiple titles 162
window 163

Title, editing 168
Tools for text formatting 164
Track Selection panel (Digitize Tool) 55
Track Selector panel, using 96
Tracking audio levels 58
Tracks

monitoring 98
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selecting 97
video, titles over 161

Transition effects
adding 149
applying 145

Transitions, selecting for trimming 114
Transparency selection boxes in Title Tool 166
Trash/Abort button (Digitize Tool) 56
Trim A-side button 117
Trim B-side button 117
Trim mode

basic procedures in 114
Big Trim mode, toggling between Small 

Trim mode 116
defined 36
entering 114
exiting 116
in workflow 40
performing 114
selecting

single transitions in 114
trim sides in 117

using Play Loop button in 115
Trim Mode button 114
Trim sides, selecting 117
Turning on the system 22
Tutorial files, installing 25

U
Undo command (Edit menu) 110
User profile, creating new 43
User settings, defined 45
User-selectable buttons 119

V
Variable-speed play See Playback
Vectorscope button (Video Input Tool) 59

Video Input Tool 58
Video Monitor buttons (Track Selector panel) 

68
Video output, preparing for 178
Video tracks, monitoring 98
Videotape, recording digital cut to 179
Viewing clips

in bins 76, 91
in monitors 91

Viewing in monitors 91
Viewing source tape name while digitizing 56
Volume, adjusting 139

W
Workspace settings, defined 46
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